
 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Thank you very much for purchasing this product. 

• To ensure correct and safe usage with a full understanding of this product's performance, please be sure to read 

through this manual completely and store it in a safe location. 

• Unauthorized copying or transferal, in whole or in part, of this manual is prohibited. 

• The specifications of this product and the contents of this operation manual are subject to change without notice. 

• This manual and the product have been prepared and tested as much as possible. If you find any misprints or 

errors, please inform Roland DG Corporation. 

• Roland DG Corporation assumes no responsibility for any direct or indirect loss or damage that may occur 

through use of this product, regardless of any failure to perform on the part of this product. 

• Roland DG Corporation assumes no responsibility for any direct or indirect loss or damage that may occur with 

respect to any article made using this product. 

 

http://www.rolanddg.com 

Copyright © 2019-2020 Roland DG Corporation 
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For the USA 

FEDERAL COMMUNICATIONS COMMISSION RADIO FREQUENCY INTERFERENCE STATEMENT 

 

Responsible Party: Roland DGA Corporation 

Address: 15363 Barranca Parkway Irvine, CA 92618 U.S.A. 

Telephone: 949-727-2100 

Type of Equipment: Laser Engraver 

Model Name: LV-290 

NOTE: 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of 

the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 

equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency 

energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 

communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case 

the user will be required to correct the interference at his own expense. 

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This 

device may not cause harmful interference, and (2) this device must accept any interference received, including 

interference that may cause undesired operation. 

FCC CAUTION 

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s 

authority to operate the equipment. 

Use only I/O cables that have been designed and manufactured specifically for this device. 

 

 

For EU Countries 
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1.1 Principles of a CO2 Laser 
LASER is the acronym for Light Amplification by Stimulated Emission of Radiation. A CO2 laser works by 

electrically stimulating the molecules within a carbon dioxide gas mixture. When focused through a lens, this 

highly-intense and invisible beam will vaporize many materials. Depending on the speed and intensity of the 

projected beam, a CO2 laser may be used to engrave or cut through a wide variety of materials. 

 

1.2 Safety Ratings 
The LV-290 is equipped with a sealed carbon-dioxide laser that emits intense and invisible laser radiation with 

a wavelength of 10.6 microns in the infrared spectrum. The laser system is designated as a Class 1 laser 

device, meaning that the system is equipped with key safety features and an enclosed laser head to 

completely contain the laser under normal use. One of the key safety features found on the LV-290 is a Class 2 

red beam safety guidance pointer (similar to a laser-pointer presentation pen) allowing the operator to see 

the exact location where the laser beam will fire. 

Even though the LV-290 is equipped with the most powerful laser to date, through proper usage and taking 

necessary hardware safeguards, will make it an extremely safe machine. 

When the front door and back door are open, machine becomes a Class 4 equipment and users must 

wear goggles to operate the machine. 

 

1.3 The Safety Interlock System 
The laser system is equipped with a safety interlock system utilizing magnetic sensors on the top and 

side access doors, laser-activation and door LED lights on the control panel. The magnetic sensors will 

deactivate the laser when either door is open. At this time, the “door” LED light found on the control 

panel will illuminate, indicating an open or improperly closed door. When the laser is in operation, the “laser” 

LED will illuminate to inform the operator that the laser is activated. If at any time, any of the access doors 

are open and the “laser” LED is illuminated, IMMEDIATELY unplug the laser system and contact your 

authorized Roland DG Corporation dealer. 

 

 WARNING 

・DO NOT operate the laser system if any component of the safety system is malfunctioning. 

・DO NOT attempt to remove or modify any component of the safety interlock system. 

 

1.4 Safety Labels 
According to CDRH standards, all fixed or removable covers that allow access to a laser beam must have an 

appropriate laser warning labels attached to them. These warning labels must be clearly visible to the 

operator prior to removing the cover. Additional labels must be applied to the interior of the machine and be 

visible in the event when the covers are removed. A label clearly displaying the manufacturer’s name, date of 

manufacture, description of product, model number, serial number, and compliance statement must be 

attached to the outer surface of the machine 

In compliance with CDRH standards, the required warning labels are affixed at the time of manufacture to the 

LV-290, attached on appropriate locations. These labels are not to be modified in any way or removed for any 

reason. Please familiarize yourself with the specific labels and their locations on the machine. Below is a list of 

all the safety labels and their locations on the machine. 
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Product Label 

This label is located at the right-back side of machine. All the product information such as Serial Number, 

Model Numbers, Laser Power and Electric power can be found here. Before requiring any further tech 

support, always provide the service person with the information on this label. 
 

LV-290 

 

CDRH Label 

This label indicates the class level of CDRH. 
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CE Label 

This label indicates the class level of CE 

 

Laser Path Warning Label 

LV-290 is very safe under normal functioning conditions. However, in case of any accident, Laser 

Path Warning Label will be affixed on the possible laser path. When operators are nearby these 

paths, they should be careful of the possible injury while the machine is operating. 

 

Warning Label 

Warning Label is written with all the necessary information to be aware of in every operation. 

 

Laser Path Danger label 

This label indicates the laser path. Normally you can find this label inside of machine. Please take 

extra caution of this area when you conduct maintenance. 
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Emergency Stop Label 

This label indicates the emergency stop button. You can find this label on the right upper side of 

the machine. 

 

Aperture warning stickers (mirror): 

This label indicates the laser path. Normally you can find this label inside of machine or laser exit. 

Please take extra caution of this area when you conduct maintenance or operate machine. 

 

Door open warning labels 

 

Warning Label 

This label is located on the laser outer case of 60W/80W/100W only 

 

Protection Window Label 

This label indicates the protection wavelength. You can find this label                           of 

window. 
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1.5 Safety Measures 

1.5.1 General Safety 

• LASER RADIATION WARNING: Exposure to laser radiation may result in physical burns and severe eye 

damage. Proper use and regular maintenance of this machine is important to the safety of all people in 

the immediate area. 

• Prior to operation, carefully read and familiarize yourself with the warning labels located on both your 

laser system and in this manual. 

• Never leave the machine unattended during the laser cutting and engraving process. The laser may 

ignite combustible materials. A well-maintained fire extinguisher and operational smoke or fire detector 

should be kept in the vicinity of the machine. 

• Caution—Use of controls or adjustments or performance of procedures other than those specified 

herein may result in hazardous radiation exposure. 

• Resulting debris from laser cutting are very dangerous and may cause fire hazard. 

• DO NOT leave debris and scraps inside laser machine after job finished. Always keep machine clean after 

job finished. 

 WARNING 

・ Resulting debris from laser processing are very dangerous and may cause fire hazard 

・ DO NOT leave debris and scraps inside laser machine after job finished. Must keep 

machine clean after job finished. 

・ Always remove the vector grid to clean any small pieces that have fallen through the 

grid. 

 

NOTE 

SmartGUARD™ is an optional fire detection alarm system. Contact your authorized Roland DG 

Corporation dealer for more details for having this safety option installed onto your system. 

 
• Enable the SmartAIR™ nozzle when engraving or cutting materials that may easily ignite, such as acrylic, 

wood, or paper. 

• Always wear safety goggles when the laser system is in operation. Reflective materials such as mirrors, 

enameled brass and anodized aluminum may partially-reflect some of the invisible laser radiation. Severe 

eye damage may occur if proper safety goggles are not worn. 

• Connect to an electrical outlet that complies with this machine’s ratings (for voltage, frequency and 

current). Incorrect voltage or insufficient current may cause fire or electrical shock. 

• Connect the machine to a properly grounded power outlet. Ensure the voltage of the power source is 

identical to the voltage of the machine. 

• When using an extension cord or power strip, use one that adequately satisfies the machine's ratings (for 

voltage, frequency, and current). Use of multiple electrical loads on a single electrical outlet or of a 

lengthy extension cord may cause fire. 

• Do not open the laser access panel when the machine is plugged in. 

• Do not attempt to modify or disassemble the laser module. 

• Do not attempt to remove or modify any component of the machine’s laser interlock safety system. 

• Ensure the immediate work area of the machine is well-ventilated. Odors, vapors, and dust are by 

products generated during the laser engraving and cutting process. An exhaust system, vacuum cutting 

box, and honeycomb table are recommended. Please contact your authorized Roland DG Corporation 

dealer for more information. 
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• Do not laser heat-sensitive surfaces or materials that may generate toxic fumes, such as PVC and Teflon. 

• Regularly clean and maintain your machine according to our cleaning and maintenance Instructions 

in Chapter 8. Doing so will ensure your machine will operate effectively and safely over a long period 

of time. 

 

1.5.2 Safety Notice for Class 4 Machine 

When the optional Pass-Through door module is installed, the laser system becomes a Class 4 machine with 

front and rear doors open, machine operators must wear goggles and follow the safety instructions to 

operate the machine. 

Exposure to a Class 4 laser beam via direct radiation and indirect stray radiation may cause damage to both 

skin and eyes. Exposure to the Class 4 laser beam may cause ignition of combustible materials which can lead 

to a fire. A proper and well-maintained fire extinguisher should keep on hand next to the laser machine all the 

times. 

The machine operator is responsible to take all necessary protective measures to prevent the possible ignition 

or explosion of materials by the laser beam. A Class 4 laser system should be operated according to the 

following precautionary measures among others: 

• The operator is obliged to appoint a trained Laser Protection Officer responsible for compliance with 

the relevant regulations. 

• Identify the danger zone by installing warning lights and warning signs outside the area. 

• The danger zone must be secured against unauthorized access. 

• The operator of a Class 4 laser system should always wear laser protection goggles suitable for the laser 

wavelength in use and with optical density at least OD5+ within the danger zone. 

• An additional warning light should also be installed in a visible location to warn the machine operator of 

any emerging laser radiation. 

 

1.6 Operating Environment 
Please follow the guidelines when considering a suitable location to set the LV-290. Improper work 

environments may lead to operational malfunction and/or unsafe working conditions. The LV-290 should be 

placed and operated in a standard office-type environment. 

• Avoid environments where the machine is exposed to high levels of dust, temperature (temperature 

exceeding 30°C or 85°F) or humidity (humidity exceeding 70% or where the ambient temperature is near 

the dew point). 

• Avoid small, enclosed areas with poor ventilation. 

• Avoid areas with high levels of noise and electrical noise. 

• Select a location that is large enough to accommodate the LV-290, an exhaust system, a computer and a 

work or storage table. 

• Select a location in which the ambient temperature remains between 15°C and 30°C (60°F to 85°F). 

• Select a location in which the relative humidity remains between 30% - 40%. 

• Select a location in which there is a short, direct path to the fume exhaust system. 

• Set the LV-290 on a floor surface that is completely even. 

• Make sure your smoke or fire detection system in the immediate area is functioning. 

• Setup the machine to be apart from the wall for at least 60 cm (2 feet). 
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1.7 Noise Test 
Test Conditions: measured at a distance of 1 meter from the surface of the machinery and a height of 1.6 

meters from the floor or access platform. 

• LV-290 Sound Test Result: 49.8 dB 
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1.8 EC-Declaration of Conformity 

EC DECLARATION OF CONFORMITY 
Manufacturer : Roland DG Corporation. 

Address of 

Manufacturer 

: 1-6-4 Shinmiyakoda, Kita-ku, Hamamatsu-shi, Shizuoka-ken, 431-2103, 

Japan 

Product Name 

 

Model No. 

: 

 

: 

Laser Engraver 

 

LV-290, LV-####@@-XXXYYY 

(#### = 1, 2 … 8, 9, 0 or blank (Table Size), @@=none character, blank, 

II, III, IV … X or A-Z; XXX & YYY = laser supplier tube model or blank) 

Directive : 2006/42/EC Machinery Directive 

2014/35/EU Low Voltage Directive 

2014/30/EU Electromagnetic Compatibility Directive 

 

For the most specific risks of this machine, safety and compliance with the essential requirements of the 

Directive has been based on elements of: 

 EN ISO 12100:2010 / Safety of machinery - General principles for design - Risk assessment and risk 

reduction 

 EN ISO 11553-1:2008 / Safety of machinery - Laser processing machines - Part 1: General safety 

requirements 

 EN 60825-1:2014 / Safety of laser products - Part 1: Equipment classification and requirements 

 EN ISO 13849-1:2015 / Safety of machine - Safety-related parts of control systems - Part 1: General 

principles for design 

 EN 60204-1:2006+A1:2009+AC: 2010 / Safety of machinery - Electrical equipment of machines- Part 1: 

General requirements- Industrial electrical device 

 EN 61000-6-2:2005 / Electromagnetic compatibility (EMC) - Part 6-2: Generic standards - Immunity for 

industrial environments 

 EN 61000-6-4:2007/A1:2011 / Electromagnetic compatibility (EMC) - Part 6-4: Generic standards - 

Emission standard for industrial environment 
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2.1 Unloading and Unpacking 
The LV-290 is shipped in one crate that contains the machine, the software, and all of the necessary 

accessories. The following section shows detailed step-by-step instructions for unpacking and assembly of the 

machine. 

 

 WARNING 

More than one person may be needed when loading and unloading the shipping crate in 

order to avoid body injury or damage to the machine 

 

NOTE 

Please store the original shipping crate as it may be needed for transportation in the future. 

 
To prevent damage to the machine or personal injury, please get assistance when loading and unloading the 

shipping crate. Please save the original shipping crate in case it is needed for future transport or product 

servicing. 

 

 

Installation location 

Before unpacking the laser system, make sure the location in which you intend to install the laser system will 

provide at least 2 feet (0.6meter) of clearance on all sides of the machine. 
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Unpacking and Unloading 

Move the shipping crate close to the desired working location of the machine. Unpack following the steps 

below. 

 

Step 1. Put the top board on the floor. Make sure the outer side faces up. 

 

Step 2. Remove the two strings  

 

  

Put the top board on the floor.  
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Step 3. Release 4 screws to take out the slide step 

 

 

Step. 4. Put the slide step next to the top board. 

 

 

  

Take out the 

Slide Step  

2 screws on the other 

side 

Top board 

Slide step 
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Step. 5 Loosen the 4 screws to take off the left and right spacer before rolling down this machine. 

 

 

Step. 6. Carefully roll down the machine off the packing crate. 

Right Spacer 

Left Spacer on 

the other side 
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2.2 How to Re-pack the Machine 
 
Step 1. Set up the ramp with the top board and slide step and carefully push the machine onto the wood 

pallet. 

 

NOTE: More than one person may be needed when loading and unloading the shipping crate in order to 

avoid body injury or damage to the machine. 

 

 

 

Step 2. Insert and lock the left and right spacer and slide step into the packing crate. 

 

Right Spacer 

Left spacer on 

the other side 

Slide step 
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Step 3. Fasten the belts accordingly and make sure the machine is affixed on the wood plate. 

  

* Put the belt into the red circle part  
 
 

Step 4. Moving the buckle to tighten the belt and buckle up as below pictures. 

  

 

Step 5. Insert four side boards on the slot of bottom plate. 

 

Step 6. Re-pack is completed. 
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2.3 Contents and Accessories Checklist 
 

Please check to make sure that all of the following items are included within the shipping crate. If any of the 

following items are missing, immediately contact your authorized Roland DG Corporation dealer. 
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2.4 Before You Use This Machine 
Before you use this machine, you must remove the tape protected mirror. 

 

Step 1. Open the front cover. 

 

Step 2. Remove a tape protected mirror. 

DO NOT touch the mirror, when you remove the tape. 

 

 

 WARNING 

You must remove the tape protected mirror, before you use the machine. Using the machine 

with the protected tape may result in fire. 

 

 

 

  

Tape 



 

                                          24                                  

 

 

 

3 
 

 

Chapter 3 Mechanical Overview 
 

 

Front View 

Top View 

Right View 

Left View 

Rear View 
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                               arize yourself with this section regarding the mechanical overview of the LV-

290. References will be made back to the different parts of the LV-290 in later sections. 

3.1 Front View 

 

3.2 Top View 

SmartEXTTM 

Pass-through Door (Front) 

Lower Front Door 

Key Switch 

Emergency Stop Button 

Control Panel 

SmartLIGHTTM Switch 
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3.3 Right (Profile) View 

 

3.4 Left (Profile) View 

 

  

Ethernet Port 

USB Port 

Power Cable Inlet 

Power On/ 

Off Switch 

USB Storage Port 

Access Panel Mirror #1 
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3.5 Rear View 

SmartEXTTM Pass-Through 

Door (Rear) 

SmartLIDTM Operation Handles 

Ventilation Openings 
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Chapter 4 Setup and Installation 
 

 

Machine Setup 
- Powering Up the Machine 

- Power Cable Connection 

- Connecting the Computer 

Graphics Software Setup 
- Recommended Computer Configuration 

- Installation of the USB Driver 

- Installation of the Print Driver 

- Installation of the SmartCONTROL 
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4.1 Machine Setup 
4.1.1 Powering Up the Machine 

 CAUTION 

Make sure both the LV-180 and computer are turned off before connecting either to a power 
source. 

 

1) Connect the male end of the power cord to a quality surge protector and then connect the surge 

protector into a properly grounded outlet. 

2) Do the same for the computer system. 

3) Connect the air compressor and external air extraction system to the laser machine before 

powering up. The connection and setup of air compressor and air extraction system refer to 

Chapter 7 for details. 

4) Connect the female end of the power cord to the machine’s power cable inlet located on the right 

side of machine. 

 

NOTE 

The LV-290 has been designed to automatically switch from 100-240 VAC. 

 
 

4.1.2 Connecting the Computer 

The LV-290 can communicate with a computer through a USB Port or LAN Port connection interface. 

Regardless of the connection method chosen, you will need to connect the respective connection cable from 

the LV-290 to your computer. 

 

4.1.2.1 USB Connectivity 

1. USB port and SmartVISIONTM Pro CCD connection port are located on right side of laser machine. 

 

 

  

USB Port 

SmartVISIONTM Pro CCD 

Connection Port 
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2. After installation of the printer driver and SmartCONTROL Vision software, please connect the USB 

cable between computer and the laser machine 

 

3. Connect the 2nd USB cable between computer and the SmartVISIONTM Pro CCD connection port 

 

 

4.1.2.2 Ethernet Connectivity 

Connect the Ethernet Cable in accessory to the Ethernet port on the right-hand side of the laser system. 

Follow below instruction for Ethernet connectivity setup. 

 

NOTE 

1. Never leave laser system unattended during laser cutting, engraving, and marking process, 

even with Ethernet or Wi-Fi connection setup, this requirement cannot be avoided. 

Exposure to the laser beam may cause ignition flame to combustible materials. 

2. DO NOT connect USB cable when using Ethernet function for data transmission. 

3. If you have purchased additional Optional Accessories for the LV-290, please refer to 

chapter 7 for instructions on how to properly setup your optional accessories. These 

should be setup prior to working with your LV-290. 
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Networking Connectivity Setup 

LV-290 is built-in with LAN port to enable multiple laser engravers to be operated by one PC and multiple 

PCs to share a single unit of laser engraver. Follow the setup instructions below. 

 

Step 1. Connect LAN cable to the LAN port of this machine and turn on machine 

Step 2. Navigate the control panel through <F4> Function→ <Machine Setting>→ <LAN Setup 

Wizard>→ IP Address. 

 

Step 3. Go to Windows <Control Panel>→ <Hardware and Sound>→ <Printer>, and right click on LV-290 

printer to check printer properties. 

 

  



 

                                          32                                  

 

 

Step 4. Go to <Ports> tab of LV-290 printer properties, and select <Add Port>, and follow the instruction 

to enter the TCP/IP information received from laser machine control panel in step 2.  
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Ethernet Connectivity Setup  

ROLAND laser engraver is built-in with LAN port to transmit data from PC to laser engraver with ease and 

higher speed instead of USB port option. 

 
Step 1. Connect LAN cable to the LAN port of this machine and turn on machine 

Step 2. Navigate the control panel through <F4> Function→ <Machine Setting>→ <LAN Setup 

Wizard>→ DHCP: OFF. 

Step 3. Navigate the control panel through <F4> Function→ <Machine Setting>→ <LAN Setup 

Wizard>→ IP Address. 

Step 4. Enter 192.168.3.X (X refers to 1~255 value which can’t be the same value with IP address setting 

in PC or Notebook) for IP, and 255.255.255.0 for MASK with UP/ DOWN keys. 

 

 

Step 5. Go to <Control Panel→Network and Internet→Network Connections> of computer, right click 

mouse on the connected internet device, and choose <Properties>. 

 

 

  



 

                                          37                                  

Step 6. Choose the <Internet Protocol Version 4(TCP/IPv4)> and click <Properties> to open up the 

setting window. 

 

Step 7. Enter the IP address and Subnet mask setting values, and choose <OK> 

Note the IP address 192.168.3.X (X value can be 1~255, while can’t be the same number as machine control 

panel setting in step 4) 
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Step 8. Go to <Control Panel> → <Device and Printers> of computer and right click on the laser 

machine printer, choose <Printer Properties>.  
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Step 9. Select <Add Pot> under Ports tab and follow the instruction to enter the TCP/IP information in 

laser machine’s control panel in step 4. 

 

 

  



 

                                          40                                  
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Troubleshooting 

While users configure the Ethernet setting precisely with DHCP = OFF (assign the machine a static IP) 

referring to the manual, sometimes the communication might still not be able to work, at this time you can 

refer to below actions to have a basic troubleshooting with IT technician. 

 

1. Verify the IP addresses you are using to see if they are valid. 

i. Open command line mode in your windows system (Press Windows key + R, the “Run” window will 

appear, type “CMD” in the blank bar then press “OK” to open command line mode) 
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Command line mode window 

 

 

ii. Type “ping x.x.x.x  –t” after the prompt symbol, (x.x.x.x is the IP address you set on the laser 

machine, ie: 192.168.100.101)., press “Enter” to run the “Ping” tool. 

 

If the communication is OK between your PC and Laser machine, you will see reply from the 

destination IP.  

 

If the communication is not ok, you will see “Request timed out” message from destination IP. 
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2. Diagnostics 

a. For cases the communication is not ok (can’t get response, just have “Request timed out” from 

destination IP), you can look for two PC/Laptops which are original set in the LAN environment 

and work ok (they can get normal response from each other by the command “PING”), note down 

the TCP/IP configurations by running “ipconfig” on both PC/Laptops (press “Windows key + R” to 

call the “Run” windows, type “CMD” in the blank bar, press enter to start command line mode, 

 

 

type “ipconfig” after the prompt symbol then press enter, the TCP/IP configurations of this 

PC/Laptop will show as below) 

 

 

Set those two IP addresses to the laser machine and the PC/Laptop which you want to communicate 

with laser. 

Test Ping again to see if you can get normal response from destination IP, if the communication is 

normal now (can get reply from destination IP), we can be sure the IP addresses we set originally are 

invalid, ask the LAN administrator to provide us a proper one. 

 

b. Directly connect the Laser machine and PC/Laptop using the RJ45 cable without any 

router/switch..etc. in between, test PING and send files, if the files can be sent and the result of PING 

is normal (can get response from destination IP), the Ethernet function of LV-290 is normal, it should 

be something wrong in the LAN environment , ask the administrator of the LAN to solve the 

problem. 
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4.1.3 USB Storage Setup 

This machine is built-in with USB storage port allow you to transmit data from USB flash drive. You can format 

and use a USB flash drive as an USB storage of this machine. 

USB flash drive minimum requirements 

 Windows FAT16/FAT32 file system format 

 A maximum of 32G of storage capacity 

 

NOTE 

• The USB storage port only supports USB flash drive 2.0. 

 

Step 1. Make sure the page setup and orientation is match LV-290. Please refer to Chapter 5.2.1 for page 

setup and orientation. 

Step 2. Open the file in graphics software and click File → Print from menu bar, and the Print window will 

appear. 

Step 3. From the navigation bar Printer. Click LV-290. 
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Step 4. Checking the Print to file checkbox and click the Print button. 

 

Step 5. Select the save folder and define file name, then click “Save” to convert. 

 

Step 6. Move the file to the USB flash drive. 
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Step 7. Insert USB flash drive to the USB Storage port of this machine. 

 

 

NOTE 

USB storage function only supported for the PRN format, you can convert the file to PRN 

format from the printer driver. 

 
Step 8. Navigate the control panel through <F4> Function→ <File Management>→ <USB Drive File> 

    

Step 9. Choose the file and press Enter button from control panel to transmit the file to laser engraver. 

    

Step 10. Press START button on control panel to begin laser jobs. 

NOTE 

File cannot be written to laser machine, please do not remove the USB flash drive if you want to 

keep process the job. 
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4.2 Graphics Software Setup 

The LV-290 is compatible with graphics software that can output HPGL commands, such as CorelDRAW, Adobe 

Photoshop, AutoCAD, Illustrator etc. 

 

NOTE 

Technical support will not be offered, if you experience output problems with non-supported 

graphics software. 

 

4.2.1 Recommended Computer Configuration 

The LV-290 operates under Windows operating systems and is designed to work on a computer that meets the 

following minimum requirements. 

 

Computer Compatibility 

• CPU – Pentium 90 (or equivalent) or greater 

• RAM – 32 MB or higher 

• HDD – 1.2 GB Hard Drive or greater 

• SVGA – 15" Super VGA Monitor 

⚫ On Board Parallel Mode (Enabled from motherboard’s BIOS) 

• SPP – Preferred Mode 

• ECP – Cable (Less than 1.8 meters) 

 

Software Compatibility 

• The LV-290 printer driver is design for Windows 7, 8.1, 10 or other operating systems developed 

subsequently. 

 

4.2.2 Installation of the Printer Driver 

1) Take out the installation disk from the accessory box and insert to CD-ROM drive of computer. Wait few 

seconds for the CD Manager to begin the setup automatically. 

2) Click on <LV-290> → <Printer Driver> from the menu of the installation CD. 
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3) Click <Next>. 

 

4) The installation would be finished in few seconds. 
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5) In the installation process, please choose the port configure, and press <OK> 

 

6) After set the port configure, installation will show the window of printer name, please click <OK> 

 

7) Click <OK> to complete the installation. 

 

 

NOTE 

When working with the LV-290 Printer Driver within your graphics software, you will need to 

have the LV-290 set as the default printer to get proper output. If you select to not have the 

LV-290 to be the default printer, please remember to manually change this on your own from 

within the graphic software printer selection area or from the Windows Control Panel → 

Printers and Faxes section. 
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4.2.3 Installation of the SmartCONTROL Vision 

1) Turn the LV-290’s power on. 

2) Take out the SmartCONTROLTM installation disk and insert to CD-ROM drive of computer. Wait few seconds 

for the CD Manager to begin the Setup automatically. 

3) Click on “Install SmartCONTROL” from the menu of the SmartCONTROLTM installation CD. 

 

 

4) Click “Next”  
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5) The installation would be finished in few seconds. 

 

6) Installation is complete, please click “OK” button to continue the Device Driver installation. 

 

7) The Device Driver Installation Wizard window will pop up, click “Next” to continue. 
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8) Windows security dialog box will appear and ask you “Would you like to install this device software?”, 

choose “Always trust software from AISYS VISION CORPRATION" and click “Install” button to continue. 

 

9) After installing the device driver, click “Finish” to close device driver installation wizard window. 

 

10) When installation is complete, SmartCONTROLTM will create a “SmartCONTROL” folder on windows desktop, 

open the folder and double click SmartCONTRL.exe to run the program. 
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4.2.4 Using Adobe’s AP with this machine  

The Adobe’s AP (e.g. Illustrator, Photoshop or Acrobat reader) processes files via its Advanced Printing Features; 

users should firstly deselect Enable Advance Printing Features; otherwise the machine is unable to recognize or 

read general files when uploaded. 

 

Deselect “Enable Advance Printing Features” 

1) Click to select → Control Panel → Devices and Printers 

 

2) Select your printer (for example, LV-290), right-click your mouse and choose Printer properties to 

enter LV-290 Properties setup 
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3) The click the Advanced tab, then deselect Enable Advanced Printing Features, now all files can be 

recognized and uploaded. 

 

 

File Transfer 

1) Select your working object, and then at the upper toolbar please choose File → Print. 
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2) At the print setup screen, at Print Preset please select Custom, and choose LV-290 printer driver. 

 

3) Then click on the “Print Settings…” button to enter Preferences settings. 

 

4) After all preferences are set, click Print to send file to the machine for print out. 
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Adobe Illustrator Output Instruction 

Step 1. Go to “Control Panel” → “Devices and Printers” 

 

 

Step 2. Right click on the icon of the laser machine model and select "printer properties" 

 

Step 3. Go to the “Advanced” tab and select ”Print directly to the printer”, then click “OK” button to 

complete the settings. 
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Step 4. Open “File Explorer” from the taskbar. 

 

Step 5. Double click the “View” tab to expand the menu bar. 

 

Step 6. Check the “Hidden items” checkbox to view hidden items. 

  

 

Step 7. Extract the file and copy the “Laser_Pen.ase” to C:\\Users\your user 

name\AppData\Roaming\Adobe\Adobe Illustrator 23 Settings\en_US\x64\Swatches 

 

If you don’t have the Laser_pen.ase file, please browse the installation CD. 

Click on <Browse CD> from the menu of the Roland DG installation CD. 

 

Step 8. Run the Adobe Illustrator. 
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Step 9. Click “File” → “New…” from the menu bar. 

 

Step 10. Click “More Settings” 

 

Step 11. Input the Width and Height of working area according to your machine model and set the Color 

Mode to “RGB”. Then click “Create Document” button to create the document. 
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Step 12. Click “File” → “Document Setup…” from the menu bar to set the document. 

 

Step 13. Click “Custom…” button and the “Custom Transparency Flattener Options” window will pop up. 
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Step 14. Set “Raster/Vector Balance” to 75, and check “Convert All Text to Outlines”, “Convert All Strokes to 

Outlines”, and “Clip Complex Regions” checkboxes, then click “OK” to close the window. 

 

Step 15. Click the “Window” from the menu bar and click the “Swatches”, and then the “Swatches” window 

will pop up 
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Step 16. Click the menu of the Swatches and select “Open Swatch Library” → “User Defined” → “Laser_Pen” 

to open the swatch library. 

 

 

 

Step 17. Draw your artwork and assign the colors from the Laser_Pen swatch library. 

 

Step 18. After the drawing is complete, please click “File” → “Print” from the menu bar, then the “Print” 

window will pop up. 

 

Step 19. Select your printer from the printer list. 
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Step 20. Click the “Setup…” button to set your parameter. Adobe Illustrator will show a message of the 

printer. Please check the “Don’t Show Again” checkbox and click “Continue” button to set the printer 

parameter. 

 

Step 21. Select your machine and click the “Preferences” button, then the “Printer Preferences” window will 

pop up. 

 

Step 22. Go to “Paper” tab and check the “CCD” checkbox if the machine has installed the SmartVISION Pro 

CCD. 
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Step 23. After the parameter setting is completed, click “OK” button to close the “Printer Preferences” 

window. 

 

Step 24. Click “Print” button to close the “Print” window. 
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Step 25. Uncheck the “Auto-Rotate” checkbox and click  icon, then click “Print” button to send the file 

to your machine. 

 

Step 26. Press the “Start/Stop” button on the control panel of the machine to start the job. 
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4.2.5 Using Autodesk Inventor with This Machine.  

1) Start drawing.  

 

2) Delete border and title block by right clicking on sheet1 and selecting delete. 
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3) Set sheet size to match working area of engraver. Engraver working area can be found on the paper tab 

of the windows driver. 

 

 

4) Start sketch. 

 

5) Engraving 

a. Finish sketch. 

b. Right click on sketch and select properties. 

c. Line Type: By Layer 

d. Line Weight: By Layer 

e. Set color to match one of the 16 colors available in the pen tab of the windows driver. 
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6) Cutting 

a. Finish sketch. 

b. Right click on sketch and select properties. 

c. Line Type: Continuous 

d. Line Weight: .001 in. 

e. Set color to match one of the 16 colors available in the pen tab of the windows driver. 

 

 

NOTE 

All objects created in one particular sketch will have the same properties meaning all will 

engrave or all will cut. If you would like to engrave and cut in the same job you will need at 

least two sketches, one with all the engravings and another with all the cuts, to do so 

properly. 
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Chapter 5 Operating LV-290 
 

 

Using the Hardware 
- Laser Key Switch 

- Adjusting the LCD Display Screen's Contrast Setting 

- Graphic Control Panel Overview (Description) 

- Graphic Control Panel Navigation Chart 

- Graphic Control Panel Function Pages 

The LV-290 Printer Driver 
- Page Setup and Orientation 

- Color Management 

- Using the LV-290 Printer Driver 

- LV-290 Printer Driver >> Options Page 

- LV-290 Printer Driver >> Pen Page 

- LV-290 Printer Driver >> Advanced Page 

- LV-290 Printer Driver >> Paper Page 

- LV-290 Printer Driver >> Language Page 
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Once you have installed the USB Driver of this machine (for use with USB connection) and have connected the 

LV-290 to your computer, you will need to familiarize yourself with the LV-290 control panel and Printer Driver. 

The printer driver will be where specific laser parameters for your jobs are configured, while the control panel 

will allow you to set repeat times, manipulate file order, perform auto / manual focusing, and more. 

5.1 Using the Hardware 

5.1.1 Laser Key Switch 

Turn the key-switch to the “ON” position BEFORE powering on the machine. If the key-switch is turned to the 

“OFF” position, the laser will be disabled meaning that the laser will not fire although the XY motion system 

will still move. The laser firing will need 8-10 seconds to warm up if turning to off, and turn on later, therefore, 

please wait 10 seconds before pressing STRART button for laser work. 

 

5.1.2 Adjusting the LCD Display Screen’s Contrast Setting 

Depending on the lighting of your immediate work area, you may need to adjust the contrast of LCD display 

screen. You may increase or decrease the display screen’s contrast via the contrast adjustment wheel found on 

the inside of the front cover on the bottom, right-hand side. You can access this area by opening the top 

window and looking inside to the rear, right side of the work area (as shown in the picture below). 

 

LCD Display Screen’s Contrast 

Adjustment Wheel 



 

                                          71                                  

5.1.3 Graphic Control Panel Overview 

The Control Panel 

The control panel on the LV-290 provides an easy access to all the manual controls needed for cutting and 

engraving. The liquid crystal display (LCD), functional, directional and selection buttons make navigating 

through the machine’s manual controls easy to do. 

 

 

 

LED Indicator Lights 

The three indicator lights on the LV-290 control panel are part of the system’s safety interlock system. 

• Door – The door light will illuminate when either the top lid or external pass through doors on the 

LV-290 are open or improperly closed. 

• Power – The power light will illuminate when the LV-290 is powered on. 

• Laser – The laser light will illuminate when the laser is active and in operation. 
 

 WARNING 

• DO NOT attempt to remove or modify any component of the safety interlock system. 

• If at any time, any of the access doors are open and the “laser” LED is illuminated, 

IMMEDIATELY unplugs the laser system and contact your authorized Roland DG Corporation 

dealer. 

• DO NOT operate the laser system if any component of the safety system is malfunctioning. 

 

Directional and Selection Buttons 

Function (F1 / F2 / F3 / F4) – Four function buttons allow you to select various functions which will 

change depending on what section of the menu you are in. Each function button’s corresponding task 

will be displayed right above its respective button on the LCD display screen. Please note that in certain 

menus, not every function button will always be mapped to a corresponding action. In these situations, 

that particular button will not have a function. 

  

LED Indicator Lights 

LCD Display Screen 

Function Buttons 

Directional and 

Selection Buttons 
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Directional ( /  /  / ) – Four directional buttons allow you to navigate the selection cursor 

through the control panel menu and adjust the value of specific settings. In general, the  /  

directional buttons cycle through the various selections, while the  /  directional buttons adjust the 

value of that particular selection. 

Enter – Confirms the current selection. 

Start / Stop – Allows you to start or stop engraving jobs, once those jobs have been successfully loaded 

onto the system. 

Delete – Provides quick access to delete the current job. 

Pause – Pauses the current engraving process. Press again to resume the current process. 

Auto Focus – After you have positioned your material and moved the lens carriage head to the area 

you want to engrave, press this button and the system will automatically adjust the optimal vertical 

focal distance for the laser. 

Manual Focus ( / ) – To manually adjust the vertical focal distance between the laser head and the 

material, you can use the  /  buttons to do so. Doing so will adjust the vertical height (z-axis) of the 

worktable. 

 

NOTE 

There is an 8-second warm up period after the door LED is triggered for systems equipped with 

Synrad laser tubes. i.e. opening the top lid or the external pass through doors of the machine. 

Operator must wait for 8 seconds before the laser tube can begin to work. 
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5.1.4 Graphic Control Panel Navigation Chart 

 

  



 

                                          74                                  

 
5.1.5 Graphic Control Panel Function Pages 

When the LV-290 is powered on, the machine will perform a series of safety checks and initialization routines. 

The LCD display screen will display the copyright, ROLAND logo, and machine initialization pages before 

going to the main work page. 

 

Main Work Page 

 

The main work page is the page that this machine will be the “home base” for when navigating through the 

various functions of the control panel. This will be the page that is displayed when you are processing your 

jobs. This page contains specific job information such as the current job’s name, Speed, Power, PPI, DPI, 

processing / remaining times, and jobs loaded. 

 

Main Work Page 

Relevant Buttons Function 

F1 (Prev) Scroll through previous jobs 

F2 (Next) Scroll through next jobs 

F3 (SP) Go to Store Position Page for SmartCENTER function 

F4 (Func) Go to Functions Page 

 /  /  /  Directional Go to Carriage / Work Table Adjustment Page 

Start / Stop Start / Stop the current job 

Delete Delete the current selected job 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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Main Work Page 

 Navigating to this page: 

Press  /  /  / 

 or F3 

Carriage / Work Table 

Adjustment Page 

Carriage / Work Table Adjustment Page 

 

 

The Carriage / Work Table Adjustment Page allow you to manually increase and decrease the height of 

the work table (Z-axis). In addition, you can manually adjust the Y-axis and X-axis of the lens carriage. 

 

Carriage / Work Table Adjustment Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F3 (Down) Manually decrease the height of the work table (Z-axis) 

F4 (Up) Manually increase the height of the work table (Z-axis) 

 /  /  /  Directional Manually adjust the Y-axis position of the lens carriage 

 /  Directional Manually adjust the X-axis position of the lens carriage 

Start / Stop Start / Stop the current job 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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Main Work Page 

 Navigating to this page: 

Press  /  /  / 

 

Carriage / Work Table 

Adjustment Page 

Fast Motion Mode Page 

 

 

 

 

 

 

 

 

The Fast Motion Mode page allows you to fast-moving the carriage to the four corners of the working 

area. It can help you take out the media/material with ease. 

 

NOTE 

To avoid operator injury, the Fast Motion Mode can’t be used when the door opens. The 

control panel will pop up a message as the below picture. 

 

 

 

Fast Motion Mode Page 

Relevant Buttons Function 

 /  Directional Manually adjust the X-axis position of the lens carriage 

 /  Directional Manually adjust the Y-axis position of the lens carriage 

Back Back to Main Work page 

Press ENTER 

Fast Motion Mode Page 
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 Navigating to this page: 

Main Work Page 

Press F3 

SmartCENTER Page 

SmartCENTER Page 

 

 

Under SmartCENTER mode the job will begin after the system positions the carriage to the center 

position between two points or four points indicated by the user. The SmartCENTER mode has to be 

enabled through the driver. 

 

Enter SmartCENTER page by pressing the <F3> button. You will be prompted to indicate and store the 

position points. The positions can be indicated by moving the carriage by hand and pressing enter to 

save the positions indicated by the red pointer. After all points are set, the carriage will move to the 

center of the stored positions and the job will begin. 

 

SmartCENTER Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F2 (Reset) Reset all saved positions 

F4 (Save) Save current lens carriage position 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Menu Page 

Functions Page 

The Functions Page allows you to edit file management and machine settings. From this page, you will 

be able to access the File Management, Machine Setting, and Machine Information pages. 

 

 

 

• File Management Page – this page allows you to manage the files that you have loaded onto the LV-

290. 

• Machine Setting Page – this page allows you to access and modify various machine settings, 

including: Set Lens, Tune Auto Focus, Set Table Down, Set Red Beam, Carriage Lock, Set Command 

Mode, Set File Save Mode, Set Vector Mode, LAN Setup, Other, Reset. 

• Advanced Option Page- this page allows you to enable different optional peripherals for the laser 

machine, such as roll to roll auto-feeder, AAS calibration for contour cutting, SmartGUARD fire alarm 

etc. 

• Machine Information Page – this page allows you to view information regarding the system such as 

the company logo, machine name, firmware version, and other information. 

* Refers to Machine Setting Page for save position and recall position functions. 

 

  

Functions Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F3 (Help) Display help 

F4 (Recall)* Recall the saved position as origin for subsequent jobs 

 /  Directional Scroll through the menu selections 

Enter Perform the selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

File Management Page 

Select <File Manage 

menu> from the menu 

File Management Page 

 

 

 

 

 

The File Management Page allows you to manage the files from system or USB drive. 

 

File Management Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

 /  Directional Scroll through the menu selections 

Enter Perform the selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

File Management Page 

Select <File Manage 

menu> from the menu 

System File Page 

Select <System File> 

from the menu 

System File Page 

 

 

 

 

 

 

 

 

 

 

The System File Page allows you to manage the files that you have loaded onto this machine. You can 

scroll through your jobs, delete a selected job, delete all jobs, and go to the Link / DLink Page to set and 

arrange multiple loaded jobs into a single job queue for processing. 

 

System File Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F2 (Link) Display help 

F3 (D-All) Back to previous page 

F4 (Del) Delete the selected job 

 /  Directional Scroll through the menu selections 

Enter Perform the selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

File Management Page 

Select <File Manage 

menu> from the menu 

USB Drive File Page 

Select <USB Drive File> 

from the menu 

USB Drive File Page 

 

 

 

 

 

 

 

 

 

 

The USB Drive File Page allows you to load file from USB storage. You can scroll through your job to 

processing. 

 

USB Drive File Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

 /  Directional Scroll through the menu selections 

Enter Perform the selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <File Manage 

menu> from the menu 

File Management Page 

Press F2 

Link / Dlink Page 

Link / DLink Page 

 

 

 

 

 

 

 

 

 

 

The Link / DLink Page allows you to set, arrange, and remove loaded jobs to and from a job queue for 

processing. Use the directional keys to cycle through your loaded jobs, then simply press the <F2 (Link)> 

key to add a file to the job queue. The job queue will be set in a sequential order based on the order you 

link the files. To remove a job from your job queue, press the <F4 (DLink)> key. 

The first column field (before the file name) displays the job number. The sequence for your job queue is 

displayed in the two columns to the right of your file names. The first column to the right of your job file 

name displays the job number of the previous file in the job queue sequence. The second column after 

the file name displays that job’s next file in the job queue sequence. First and last jobs in the job sequence 

you set will have a (---) in the first and second columns respectively. So according to the image above, 

the job queue sequence has been set to be processed in this order: 03:Marble.cdr  01:Marble.cdr  

02:Marble.cdr. 

 

Link / DLink Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F2 (Link) Add the currently-selected job to the job queue 

F4 (DLink) Remove the currently-selected job from the job queue 

 /  Directional Scroll through the menu selections 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

File Management Page 

Select <File Manage 

menu> from the menu 

File Information Page 

Select a job file and 

press Enter 

File Information Page 

 

 

 

 

 

 

 

 

 

 

The File Information Page allows you to view the speed, power, DPI, and PPI settings of the selected job. 

In addition, you will be able to go to the File Management Edit Page from this menu to change raster/ 

vector speed and power settings for the selected job. 

 

File Information Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Edit) Go to the File Management Edit Page for the selected job 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <File Manage 

menu> from the menu 

File Management Page 

Select a job file and 

press Enter 

File Information Page 

Press F4 

File Management Edit Page 

File Management Edit Page 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The File Management Edit Page allows you the choice to modify your raster or vector settings for the 

selected job, as well as setting the number of times to repeat the process of the selected job (Repeat 

Num). 

 

File Management Edit Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

 /  Directional Scroll through your loaded jobs 

 /  Directional Cycle through the available selections 

Enter Perform the selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <File Manage 

menu> from the menu 

File Management Page 

Select a job file and 

press Enter 

File Information Page 

Press F4 

File Management Edit Page 

Select <Raster Setting> 

from the menu 

File Edit Raster Page 

File Edit Raster Page 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The File Edit Raster Page allows you to edit the raster power and speed settings, as well as enable or 

disable SmartACT for the selected job. These settings correspond to the same settings found on the 

printer driver. This page allows you to easily adjust these values to make immediate adjustments while 

processing your loaded jobs, even when you have disconnected your computer from this machine. 

• Raster Power: 0.0% - 100% 

• Raster Speed: 0.0% - 100% 

• SmartACT: YES/ NO 

 

File Edit Raster Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

 /  Directional Scroll through your loaded jobs 

 /  Directional Cycle through the available selections 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <File Manage 

menu> from the menu 

File Management Page 

Select a job file and 

press Enter 

File Information Page 

Press F4 

File Management Edit Page 

Select <Vector Setting> 

from the menu 

File Edit Vector Page 

File Edit Vector Page 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The File Edit Vector Page allows you to edit the vector pen, vector power, vector speed, and vector PPI, 

and power ramp settings for the selected job. These settings correspond to the same settings found on 

the printer driver. This page allows you to easily adjust these values to make immediate adjustments while 

processing your loaded jobs, even when you have disconnected your computer from this machine.  

• Vector Pen: 1 - 16 

• Vector Power: 0.0% - 100% 

• Vector Speed: 0.0% - 100% 

• Vector PPI: 30 - 1524 

• Power Ramp: YES/ NO 

 

File CorelDRAW Vector Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Scroll through your loaded jobs 

 /  Directional Adjust the value for that selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Machine Setting Page 

 

 

 

 

 

The Machine Setting Page allows you to access and modify various machine settings, including: Set Lens, 

Tune Auto Focus, Set Table Down, Red Beam on/ off, Carriage Free, select Command Mode, File Save, 

Select Vector Mode, LAN setup, Other, and Reset etc. 
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Machine Setting Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F3 (Next) Scroll to next page  

F4 (Prev) Scroll to previous page 

 /  Directional Scroll through your loaded jobs 

Enter Perform the selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Select Lens> 

from the menu 

Set Lens Page 

Machine Setting- Select Lens Page 

 

 

 

 

 

 

 

 

 

 

The Select Lens Page allows you to modify the lens settings after you have changed to a different focal 

lens. Remember to save your settings after you have made the proper changes. After that, pressing the 

Auto Focus button on control panel, the laser machine will conduct auto focus accordingly using the new 

lens setting.  

This machine includes different models which equipped different laser tubes, make sure the laser tubes 

installed with your machine before making adjustment.  

• CO2 Laser Focal Lens: 1.5"/ 2.0"/ 2.5"/ 4.0" (Default 2.0”) 

 

 

Select Lens Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Cycle through selections 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Tune Auto 

Focus> from the menu 

Tune Auto Focus Page 

Machine Setting- Tune Auto Focus Page 

 

 

 

 

 

 

 

 

 

The Tune Auto Focus Page allows you to manually adjust the auto focus default value, or distance from 

lens carriage to the worktable (Z-axis) when the Auto Focus button is pressed. 

This machine includes different models which equipped different laser tubes, make sure the laser tubes 

installed with your machine before making adjustment. 

 

Tune Auto Focus Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Manually adjust the height of the work table (Z-axis) 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Table Down> 

from the menu 

Table Down Page 

Machine Setting- Table Down Page 

 

 

 

 

 

 

 

 

 

 

The Set Table Down Page allows you to select whether or not this machine, displays a table moving down 

warning message at startup. If the Table Down selection is set to <YES>, this machine will display a 

warning message at startup stating: “Table will move down and remove objects on table”. Pressing the 

Enter key at this point will confirm the prompt to move the work table to its lowest position. If the Table 

Down is set to <NO>, this machine will not display the warning message at system startup. 

• Table Down: YES/ NO 

• Distance: 0 - 165 mm  

 

 Table Down Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Scroll through the menu selections 

 /  Directional Adjust the value for that selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 



 

                                          92                                  

 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Red Beam> 

from the menu 

Red Beam Page 

Machine Setting- Red Beam Page 

 

 

 

 

 

 

 

 

 

 

The Red Beam Page allows you to turn on or off the red dot laser pointer on the lens carriage. Enabling 

this function will indicate the exact area the engraving laser will fire upon. 

• Red Beam YES / NO 

 

Red Beam Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Cycle Red Beam between YES / NO 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Carriage Free> 

from the menu 

Carriage Free Page 

Machine Setting- Carriage Free Page 

 

 

 

 

 

 

 

 

 

 

The Carriage Free Page allows you to decide whether the lens carriage to be locked or free for hand 

movement. If the Carriage Free setting is set to <YES>, then you will be able to manually move the lens 

carriage along the X and Y axis by hand with the top door open. Whereas setting the Carriage Free to 

<NO> will lock the lens carriage and movement or positioning can only be done by the control panel 

arrow keys. 

• Carriage Free YES / NO 

 

Carriage Free Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Cycle Red Beam between Back / Save 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Command 

Mode> from the menu 

Command Mode Page 

Machine Setting- Command Mode Page 

 

 

 

 

 

 

 

 

 

 

The Command Mode Page allows you to configure vector settings when outputting in Default or HPGL 

mode. Default mode refers to output the file through standard Windows print driver and also recognized 

by the most popular graphic software programs such as CorelDRAW, Photoshop, Illustrator, and more. 

Whereas, HPGL mode is a less common output format generated from some RIP applications (signage 

industry). Regardless of which format you will be working with, both output formats are supported.  

• Mode: Default / HPGL 

• Vector Pen: 1 - 16 

• Vector Speed: 0.0% - 100% 

• Vector PPI: 0.0% - 100% 

• Power Ramp: YES / NO 

 

Command Mode Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Scroll through the menu selections 

 /  Directional Adjust the value for that selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <File Save 

Mode> from the menu 

File Save Mode Page 

Machine Setting- File Save Mode Page 

 

 

 

 

 

 

 

 

 

 

The File Save Mode Page allows you to set whether or not this machine, automatically deletes each job 

file after processing. Setting File Save to <NO> will automatically and immediately delete each job file 

from this machine, after the engraving or cutting process. Setting File Save to <YES> will retain the job 

files on this machine.  

• File Save: YES / NO 

 

File Save Mode Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Cycle File Save between YES / NO 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Set Standby 

Mode> from the menu 

Set Standby Mode Page 

Machine Setting- Set Standby Mode Page 

 

 

 

 

 

 

 

 

 

 

The Set Standby Mode page allows you to configure the laser machine automatically enter into power 

saving if machine is idle for a specified time.  

When entering into the Set Standby Mode function, you can use Left or Right arrow keys to scroll 

between <Enable> or <Disable> the function. The Time function is to determine after how long the laser 

machine is idle, it will enter in power saving automatically. The default time is 4 minutes. The Enter 

Standby function will turn the machine into power saving immediately after selected. 

• Standby: Enable/ Disable 

• Time: 4-30 mins. (Default 4 mins.) 

• Enter Standby: YES/ NO 

 

Set Standby Mode Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Cycle standby mode between YES / NO 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Directional Scroll between menu options  

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Set Position> 

from the menu 

Save Position Page 

 Navigating to this page:  

Main Work Page 

Press F4 

Functions Page 

Press F4 

Machine Setting- Save Position Page 

 

 

 

 

 

 

 

 

 

 

The Save Position Function allows you to save the current X-axis and Y-axis positions of the lens carriage 

to be the origin for subsequent jobs. 

Tip 

This is an excellent function to use when you are processing identical items or engraving 

relatively smaller objects positioned away from the default start position (top left) of the work 

table. 

 

Recall Position 

 

 

 

To recall the saved position, simply go to Functions page and press F4 again to recall the saved position. 

The lens carriage will be moved to the saved position and start subsequent jobs from this origin.  
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Vector Mode> 

from the menu 

Vector Mode Page 

Machine Setting- Vector Mode Page 

 

 

 

 

 

 

 

 

 

 

The Vector Mode Page allows you to adjust and balance vector mode’s quality and speed settings based 

on your specific job. Speedy Vector Mode offers the highest output speed, sacrificing quality. Whereas 

Quality Vector Mode offers the highest quality, sacrificing output speed. Keep in mind that speed and 

quality are usually at a tradeoff. The system’s default is quality Vector mode. 

• Modes: Quality, Production, Speedy 

[Slower speeds / higher quality -------------------- Faster speeds / lower quality] 

 

The machine will reboot automatically after clicking <Save> button for the change. 

 

Vector Mode Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional 
Cycle Set Vector Mode between QUALITY/ FINE/ COARSE/ 

SPEEDY VECTOR 

 /  Directional Scroll through menu options 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <LAN Setup 

Wizard> from the menu 

LAN Setup Wizard Page 

Machine Setting- LAN Setup Wizard Page 

 

 

 

The LAN Setup Wizard Page allows you to connect the laser machine with ethernet to transmit files from 

computer to laser machine for processing jobs. When selecting the DHCP to <ON>, the network is set tup 

to dynamic IP address, the IP address will automatically retrieve from network; while DHCP <OFF> is to 

apply static IP address, and you need to further enter the IP address, MASK, and GATE information. Using 

Left or Right directional keys under dynamic IP setting page to scroll between different columns to enter the 

address, and use Up or Down keys to change the numbers.  

• DHCP: ON/ OFF 

Please refer to Chapter 4.1.2 for ethernet connectivity setup in Windows driver. 

LAN Setup Wizard Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional 
Cycle DHCP between NO/ OFF, or move between tabs on IP 

address settings 

 /  Directional 
Scroll between menu options or change the numbers of IP 

address settings.  

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Scaling> from 

the menu 

Scaling Page 

Machine Setting- Scaling Page  

 

 

 

 

 

 

 

 

 

 

The Scaling Page allows you to fine tune the laser machine output scale to precisely fit the original graphic 

file design scale when precision output is requried to your application.  

 

Please reboot the machine after clicking <Save> button for the change.  

 

Scaling Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Adjust the X axis scaling numbers 

 /  Directional Adjust the Y axis scaling numbers 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Others> from 

the menu 

Others Page 

Machine Setting- Others Page 

 

 

 

 

 

 

 

 

 

 

The Others Page allows you to change various settings that correspond to the control panel. The 

Language setting will allow users to change available languages displayed on the control panel.  

The Unit setting will allow you to change whether the units displayed by the control panel is in the metric 

or imperial system. The EOF (end of file) Alarm setting will enable or disable an audible notification when 

jobs are complete. The Air Delay setting allows you to specify the delay in seconds of the SmartAIR air-

assist after the point of laser firing. 

• Language: ENGLISH (others dependent on Firmware) 

• Unit: METRIC/ INCH 

• EOF Alarm: YES/ NO 

• Air Delay: 1-100 seconds 

Tip 

Depending on the material you are working with, your laser settings, and the desired results, 

please experiment with the air delay to achieve your desired results. 

 

Others Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Scroll through the menu selections 

 /  Directional Adjust the value for that selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Machine Setting Page 

Select <Reset> from 

the menu 

Reset Page 

Machine Setting- Reset Page 

 

 

 

 

 

 

 

 

 

 

The Reset Page will restore machine settings back to factory default. Press ENTER to confirm the change 

and restart the machine. 

 

Reset Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

 /  Directional Scroll through the menu selections 

Enter Perform the selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Advanced 

Option> from the menu 

Advanced Option Page 

Advanced Option Page 

 

 

 

 

 

The Advanced Option Page allows you to access multiple setting for laser machine optional peripherals, 

including SmartGUARD, Rotary Select and Origin Mode. 

 

Advanced Option Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F3 (Next) Scroll to next page 

F4 (Prev) Scroll to previous page 

 /  Directional Scroll through menu options 

Enter Perform the selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Advanced 

Options> from the 

menu 
Advanced Option Page 

Select <SmartGUARD> 

from the menu 

SmartGUARD Page 

Advanced Option- SmartGUARD Page 

 

 

 

 

 

 

 

 

 

 

After optional SmartGUARD hardware installation, please enter the function menu on the control panel 

to enable the SmartGUARD fire alarm. Note SmartGUARD fire alarm system is not a fire extinguisher, but 

a fire detecting and alarm system. 

 

SmartGUARD Enable/ Disable: 

Press directional key (Left or Right) to enable the SmartGUARD device or disable it. 

Sensitivity: 

Press directional key (left or right) to set the sensitivity of SmartGUARD. There are seven sensitivity settings 

that can be selected. Sensitivity defines the delay time from when a fire is detected until the fire alarm 

alerts user, and automatically stop laser firing. For example, if the sensor delay switch is set to the 3-second 

position, the SmartGUARD will start an alarm and automatically stop laser firing after detecting a fire for 3 

seconds. 

Stow Carriage: 

This function will decide if the lens carriage stay in the last position (set to <NO>) or move to the opposite 

direction (up or down) when fire alarm is initiated. The default is <YES>, the lens carriage will move to 

opposite direction when a fire detected. 

 

SmartGUARD Setting Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Scroll through the menu selections 

 /  Directional Adjust the value for that selection 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Advanced 

Options> from the menu 

Advanced Option Page 

Select<Origin Mode 

Page>from the menu 

Tune Origin Mode Page 

Advanced Option- Origin Mode Page 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Origin Mode Page allows you to manually adjust the origin (top left) position default value. When 

machine is installed with the aluminum grid cutting table, please select “Option Mode”. If you remove the 

aluminum grid cutting table, please select “Origin Mode” -as the origin position. 

 

This machine includes two different origin positions that depend whether you install the aluminum grid 

cutting table or not. You are able to set Origin Mode (without grid cutting table) or Option Mode (with 

grid cutting table) as default value. 

 

Tune Origin Mode Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

F4 (Save) Save your current settings 

 /  Directional Scroll through the menu selections 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 

 

  

Select “Origin Mode” or 

“Option Mode” 

Option Mode 



 

                                          106                                  

 Navigating to this page: 

Main Work Page 

Press F4 

Functions Page 

Select <Machine 

Setting> from the menu 

Information Page 

Information Page 

 

 

 

The Information Page allows you to view information regarding the system such copyright, laser machine 

name, firmware version, and other information. 

 

Information Page 

Relevant Buttons Function 

F1 (Back) Back to previous page 

 /  Directional Scroll through the menu selections 

Start / Stop Back to Main Work Page 

Auto Focus Initiate the auto focus function 

 /  Manual Focus Buttons Manually adjust the height of the work table (Z-axis) 
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5.2 The LV-290 Printer Driver 
With the printer driver successfully installed, you will need to adjust the printer and page size default settings 

before you can begin editing and completing jobs. By doing so, you will be setting the work area in your 

graphics software to match the work table area. 

 

NOTE 

Please make sure this machine is set to the default printer before proceeding to the page and 

layout setup. 

 
Ensure that the LV-290 has been selected as the DEFAULT PRINTER. You can do so by going into your 

Windows Control Panel → Printers and Faxes. If the LV-290 is not selected as DEFAULT PRINTER, you may set 

it up through the graphics software as well. The following example takes CorelDRAW to demonstrate how to 

set up LV-290 as the Printer. 

1) From the primary menu, click FILE → PRINT SETUP. 

2) From the navigation bar Name, click LV-290 → OK 
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5.2.1 Page Setup and Orientation 

The first thing you must do before working with the LV-290 Printer Driver will be to make sure the page and 

layout settings are properly configured within your graphics software. You will need to access and edit the 

Page Setup or Layout page of your graphics software to set your graphics software’s page layout to match this 

machine’s work table’s dimensions and orientation. 

From your graphic software’s Page Setup page: 

• Set the page orientation in the graphics software to Landscape mode. 

• Set page size to match laser machine work area size. 

◼ LV-290: 640x460 mm (25.19”x18.11”) or 740x460 mm (29.13”x18.11”) with extended mode 

CorelDRAW Example (Page Setup and Orientation) 

The following is an example of how to set the Page Setup and Orientation in the graphics software. 

CorelDRAW is the designated graphics software used for this example. For another graphics software, 

you will need to access the corresponding Page Setup page. 
 

1) From the primary menu, click LAYOUT → PAGE SETUP. 

2) From the navigation bar on the left, click DOCUMENT → PAGE → SIZE. 

3) Ensure that NORMAL PAPER and LANDSCAPE are selected. 

4) Ensure the Paper Width and Height dimensions match the LV-290 work area dimensions. 

◼ LV-290: 640x460 mm (25.19”x18.11”) or 740x460 mm (29.13”x18.11”) with extended mode 

5) Click OK to end the paper size adjustment. 

 

Tip 

Instead of manually selecting the Landscape and setting the Paper Width and Height, you can 

simply click the Set from Printer function and CorelDRAW will automatically set the proper 

orientation and dimensions based on this machine’s work table. (You MUST have the LV-290 

set as the default printer prior to doing this.) 
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5.2.2 Color Management 

The printer driver uses pen color settings to control laser engraver’s engraving and cutting parameters. 

In addition to having your Page Setup and Orientation properly set in your graphics software, you will 

also need to make sure Color Management is DISABLED prior to working with the LV-290 Printer Driver. 

From your graphic software’s Color Management page: 

• Disable Color Management or set Color Management to Off. 

 

CorelDRAW Example (Color Management) 

The following is an example of how to properly disable Color Management in the graphics software. 

CorelDRAW is the designated graphics software used for this example. For other graphics software, you 

will need to access the corresponding Color Management page. 

1) From the primary menu, click TOOLS → COLOR MANAGEMENT and CorelDRAW’s Color 

Management will appear. 

2) Under the Style pull down menu, select COLOR MANAGEMENT OFF. 

3) Click OK to complete the color management adjustments. 
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5.2.3 Using the Printer Driver 

Now after you have properly set the Page and Layout and Color Management of your graphics software, 

you are ready to configure the details of your actual job through the LV-290 printer driver. The Printer 

Driver allows you to adjust your engraving / cutting options. After you have setup your image, design, or 

text to be engraved in your software application, you can access the Printer Driver by going to <FILE> → 

<PRINT>→ <PROPERTIES>. 

 

 

NOTE 

CorelDRAW was used as the software application for this screenshot example. 

 
The LV-290 Printer Driver consists of seven primary sections (pages) in which you will be able to choose 

various engraving / cutting options and settings: 

 

• Option Page 

• Pen Page 

• Advance Page 

• Paper Page 

• Language Page 

• Raster Page (appears only in Black & White Mode) 

• Stamp Page (appears only in Stamp Mode) 

 

Tip 

The following sections describe the specific functions for each of the settings found in the LV-

290 Printer Driver. If you are new to laser engraving, it is recommended that you first familiarize 

yourself with the general principles of the laser process in Section 6, especially the Vector 

Cutting and Raster Engraving concepts. This will make it easier to understand the various 

descriptions and terminologies used in this section. 
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5.2.3.1 LV-290 Printer Driver >> Options Page 

 

Mode Setting (OPTIONS PAGE) [DEFAULT SETTING: Black & White] 

You can select from four primary mode settings, depending on your application or results you would 

like to achieve. 

 

Black & White: 

Select this mode when using clipart images or drawings with several colors, shades of gray, or many 

outlines. This mode outputs in a method similar to that of a black and white laser printer. 

The Printer driver will interpret colored and shaded areas as 256-level shades of gray by producing a 

halftone effect while engraving. Instead of engraving only solid lines, gray or halftone areas will be a 

collection of dots with varying density. 

The entire selected image will be engraved using a single set of power and speed settings (the black 

pen from the PEN menu. Please refer to the next section of the details regarding the PEN functions). 

The resolution and depth of these halftone areas can be adjusted with the DPI setting found on the  

Options page. Please note that selecting the Black & White mode will add a new Raster page to the 

menu. The Black & White mode dithering settings can be changed from the Raster page. (Please refer 

to the Raster section below for details). Experiment with different dithering settings to attain the desired 

results. 

 

Tip 

The Black & White mode interprets the processed image by the varying colors and shades. For 

the best results, we suggest you convert the image to a grayscale image with your graphics 

software prior to engraving in the Black & White mode. 

 

NOTE 

Selecting the Black & White mode will enable the Raster page on the LV-290 Printer Driver, 

allowing you to adjust advanced stamp-related settings. 
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Manual Color Fill: 

Specify laser speed and power to different color pens. The VL-290 printer driver allows a maximum of 

16 pen parameters to be set. It will help user to set different parameters easily in one file. 

 

3D Mode: 

3D Mode allows the naked eyes to visualize the curvatures of the 3D effect by applying 200 grayscale 

power level technology to create different depth of engraving. 

 

Stamp Mode: 

The stamp mode is one of the more dynamic functions of the LV-290 laser engravers by applying 200 

power levels to create different steps.  

 

NOTE 

Selecting the Black & White mode will enable the Raster page on the LV-290 Printer Driver, 

allowing you to adjust advanced stamp-related settings. 

 

Raster & Stamp Mode: 

Select this mode when you would like to engrave image on stamps. The Raster & Stamp mode combines 

the 256-level gray scale image processing technology and 200 power level stamp steps production 

requirement to create slopes. 

Noted Raster & Stamp mode is only suitable for CO2 laser system 
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DPI (Options Page) [DEFAULT SETTING: 500] 

DPI (dots-per-inch) represents the number of times the laser will fire over a one-inch path. This setting 

determines the image resolution and quality when performing raster engraving functions. Higher DPI 

settings result in cleaner and deeper engravings but require more time to complete. Lower DPI settings 

result in coarser and shallower engravings but require less time to complete. The LV-290 offers 8 DPI 

options: 125, 250, 300, 380, 500, 600, 760, 1000, and 1500 experiment with different settings to get your 

desired effect. 

 

Below is a chart for your convenience detailing the Set DPI (your input setting) vs. Actual DPI (your output 

results). 

Set DPI 125 250 300* 380 500 600* 760 1000 1500 

Actual DPI 127 254 381 381 508 762 762 1016 1524 

 

NOTE 

Outputting a full-table (25.1" x 18.1") job using 300 or 600 DPI will result in a truncation error; 

this is due to the large differences in set DPI vs. actual DPI output for those two particular DPI 

settings. Therefore, when processing a 25.1" x 18.1" job using 300 DPI, we recommend you 

move to the next higher DPI setting of 380. Similarly, for a 25.1" x 18.1" job using 600 DPI, we 

recommend you use 760 DPI. 

 

Mirror (Options Page) [DEFAULT SETTING: Unselected] 

Checking this box will automatically engrave your image with a mirrored effect. This setting will flip the 

image along the Y-axis from left to right and vice-versa. 

 

Tip 

When engraving a stamp, via the stamp mode, the stamp image needs to be engraved in 

reverse (mirrored) for the final stamp to be correctly laid out. 
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Invert (Options Page) [DEFAULT SETTING: Unselected] 

Checking this box automatically inverts / reverses the color of your image (the white areas become 

black and vice versa). The Invert option is not available if disabled while Manual Color File mode is 

selected. 

 

Tip 

Invert mode is useful when creating a stamp in Stamp Mode, as inverting your normal image 

will set the negative space to be engraved out, with the remaining positive space (your stamp 

design) protruding out. 

 

Print Immediately (Options Page) [DEFAULT SETTING: Unselected] 

Checking this will instruct the LV-290 to immediately begin the laser engraving process, when you select 

Print from your graphic software program. If Print Immediately is not checked, then selecting Print will 

transfer the job file to the LV-290 system and will need to be initialized from the LV-290 control panel. 

 

SmartACT (Options Page) [DEFAULT SETTING: Unselected] 

By eliminating unnecessary travel of the lens carriage at the expense of some quality, SmartACT reduces 

the acceleration area to save of time to process a job! 

 

 

Tip 

There is a greater performance gain when enabling SmartACT for designs that are vertically 

longer than they are horizontally wide, as the SmartACT optimization modifies the movement 

of the X-axis of the lens carriage. 
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Preview (Options Page) [DEFAULT SETTING: Unselected] 

Users can use the Preview function to check a simulated output of the job. An estimated working time 

will also be shown. Please make sure to set the file printing option to “print to file” in order to activate 

the Preview function. 

 

A filename will be prompted. 
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After entering the filename and pressing <ok>, the Preview screen will be shown. 

 

The output file can be previewed and an estimated working time of the job is also displayed. 

 

File Function (Options Page): 

The file function section allows you to manage various laser parameters. This section is useful when 

performing duplicate jobs on a variety of objects, allowing you to save your frequently used laser 

parameters and load them in the future. 

• History File: This section contains a list of the recent files you have recently created and worked with. 

• SAVE: This function will save the current print driver parameter settings to a file and location on your 

computer of your selection. (Saved parameter setting files will be tagged with the .Spi extension) 

• LOAD: This function allows you to load those previously saved print driver parameters. 

• ORIGINAL: This function will load the print driver’s original factory parameter settings. 

• SAVE TO DEFAULT: This function allows you to save your current print driver parameters as the 

default startup settings. 

  



 

                                          117                                  

• PARAMETER: The material database consists of pre-built-in parameter settings to work with a wide 

variety of material including wood, acrylic, glass, 2py-laminated plastic, marble, tiles, rubber, coated 

metal, and more. With this convenient function, users can easily set up their tool by selecting the 

appropriate job type (engraving or cutting) and material categories for the corresponding 

parameters to be applied. 

 

• DELETE: This function will delete the file you select from the History File section. Please note the 

Delete function only removes the file from the history file section, it does not remove the .Spi file 

from your hard drive, if you wish to completely remove the file from your hard disk, then you will 

have to manually delete the file from your operating system.) 

 

NOTE 

If you are using Windows as your operating system, make sure you log in with an 

administrator or administrator-rights account in order to properly save laser parameter 

settings. 

 

Tip 

LV-290 material database settings allow you easy to load the several parameters. 

If you are loading LV-290 parameter database as your operating parameter, please click 

<Parameter> under OPTIONS page, and direct load from several build-in parameter folders. 
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5.2.3.2 LV-290 Printer Driver >> Pen Page 

The LV-290 incorporates the use of 16 different colors to represent 16 different laser power and speed 

settings when cutting and engraving. These colors are referred to as “Pens”. Think of each pen as a 

designated laser setting, rather than as a color. As an example, a black and white image will use only 

one power and speed laser setting (Black). An image that is made up of black, red and blue colors will 

be processed using the laser settings designated for each particular color. In order to utilize up to 16 

different pens (laser parameter settings), make sure your graphics software can recognize and utilize 

the 16 pen colors designated by the LV-290 printer driver. 

 

If you would like to specify your own colors to designate to a particular laser setting, then all you have 

to do is to double-click on that particular pen color from the pen menu and a color manager window 

will open where you can select “define custom colors” to define your own color (shown in the picture 

below). This is useful when your image is composed of colors that are not part of the pen menu’s default 

color selection, and instead of modifying your image, you simply assign the laser settings based on the 

existing colors depicted from your current image. 

 

NOTE 

The LV-290 printer driver cannot store more than 16 pen colors or different laser parameter 

settings per file. 
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Speed (Pen Page) [DEFAULT SETTING: 50] 

The speed slider controls the laser’s speed during operation (engraving speed) with settings ranging 

from 0.1 – 100%. Keep in mind, the speed setting refers to the lens carriage moves at when cutting or 

engraving straight lines. The machine will automatically slow down when processing curves. 

 

Tip 

Cutting / engraving depth and quality are determined by a combination of power and speed. 

Slower speeds at higher power will produce deeper cuts and engravings, whereas higher 

speeds at lower power will produce more shallow cuts and engravings. 

 

Power (Pen Page) [DEFAULT SETTING: 50] 

The power slider controls the laser’s power during operation (engraving power) with a range setting 

from 0 – 100%. The percentage setting represents the power for each laser pulse fired. 

 

PPI (Pen Page) [DEFAULT SETTING: 400] 

PPI (pulses-per-inch) represents the number of times the laser pulses (fires) per linear inch, exclusive for 

vector cutting. Higher PPI settings will generate deeper, overlapping laser pulses, resulting in cleaner 

cuts. Lower PPI settings (lower than 150) will result in the individual laser pulses being spread apart, 

resulting in a perforated effect (similar to the perforation in the paper between mailing stamps).  

 

If you drag the PPI slider to the furthest right (maximum), the value will change to X. This completely 

disables the PPI control and continuously fires the laser non-stop, without pulsing. 

Think of setting PPI to X as being equivalent to turning a water faucet on with the water continuously 

flowing out. This also disables the power ramp functionality, which automatically controls the PPI 

depending on the speed of the lens carriage (such as vector cutting around the corner of a square). 

 

Tip 

Cutting / engraving depth and quality are determined by a combination of power and speed.  

Slower speeds at higher power will produce deeper cuts and engravings, whereas higher 

speeds at lower power will produce shallower cuts and engravings. 

 

Raster / Vector (Pen Page) [DEFAULT SETTING: Selected] 

Checking the Raster checkbox will process only the raster functions for the areas of your design that 

correspond to that particular “pen” color. 

Checking the Vector checkbox will process the vector functions for the areas of your design that 

correspond to that particular “pen” color. 

As an example: a particular “pen” color may be assigned to areas in your design containing color fills 

(raster engraving) and very thin lines (vector cutting). By checking / unchecking the Raster and Vector 

will force the driver to process / ignore the color fills / thin lines. 
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Air (Pen Page) [DEFAULT SETTING: Unselected] 

This checkbox controls the SmartAIR air-assist function (if you have the optional air compressor installed). 

By selecting a pen color and checking this box will enable the SmartAIR air -assist function for that 

particular pen color. As an example, if you are performing a combination of both surface raster engraving 

job and deep vector cutting on a material such as acrylic, you may want 

to enable the SmartAIR air-assist for the vector cutting sections to get the cleanest cuts. To do this, you 

would simply need to select the pen color that you have assigned to the sections to be cut and select 

the Air checkbox for those particular pen colors. 

 

NOTE 

In order to use the Air Delay function under the firmware or the Air assist function in the 

driver, make sure that the optional air compressor is connected to the power outlet located 

in the lower machine cabinet. There are two power outlets located in the right-hand side of 

the lower machine cabinet, make sure that the air compressor is connected to the power 

outlet towards the left which is closer to the fuse. 

 

Auto Focus (Pen Page) [DEFAULT SETTING: Unselected] 

This checkbox sets the Auto Focus for that particular job. With the Auto Focus button checked, LV-290 

will automatically initialize the auto focus procedure before starting the job. This will ensure the focal 

distance is properly set based on the particular material you are working with and the focal lens you 

have installed. 

 

Defocus (Pen Page) [DEFAULT SETTING: Unselected] 

This checkbox enables users to set the Defocus or out of focus distance for a particular job. With the 

Defocus button checked, the LV-290 will use the entered focus distance when performing the auto focus 

procedure before starting the job. This feature allows users to use out of focus engraving techniques 

when working with different types of materials. Note that the Defocus distance is set by the different 

pen colors. 
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Bridge Cutting (Pen Page) [DEFAULT SETTING: Unselected / 0.0 mm] 

Checking the Bridge Cutting checkbox will allow users to easily create perforation lines (dash-line).  

Once see the line color along with another corresponding pen can be used in tandem to indicate the 

length of the gap and the uncut part of a perforation line. (If Pen 1 is selected for bridge cutting, Pen 9 

will be reserved to the length of the connected lines of the perforation. If Pen 2 is selected, Pen 10 will 

be reserved and so on…) 

 

 

5.2.3.3 LV-290 Printer Driver >> Advanced Page 

 

Scaling (Advanced Page) [DEFAULT SETTING: 0] 

In some cases you may find a slight output inaccuracy in the actual output compared to what you have 

set in the computer. This margin of error or offset is extremely small (approximately 1/300). What this 

means is that there may be a 1-unit offset for every 300 unit increments. As an example, if you engrave 

a 300mm straight line, it may end up measuring only 299 mm or 301 mm in the final output. In this 

case, you will want to set the scaling setting to +1/1000 or -1/1000 respectively to compensate. A 

general rule of thumb is for every 300 unit increment, you will want to adjust the slider by +1 if the final 

output is 1 unit increment shorter or -1 if the final output is 1 unit increment longer than your graphic 

design setting. 
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Position Modes (Advanced Page) [DEFAULT SETTING: Home] 

These selections allow you to control the positioning of the laser head after each job completion and 

before the next subsequent job. 

• Home: Resets the positioning of the laser head to the ‘home position’ (upper-right) before and after 

each job. 

• Without Home: The laser head will start the next job based on the position from its graphic 

application software setting, from the last position of the previous job. Upon completion of the 

current job, the laser head will remain at the last position of the previous job. 

• Relative: This mode sets the current laser head position to correspond to the origin (top left) position 

of the graphic software. Therefore, the laser head will process the job from its current position relative 

to its setting in the graphics software. 

• Center: Sets the current position of the laser head as the center point for your subsequent job. As 

an example, if the subsequent job is to vector cut a circle and you have the Position Mode set to 

Center, then the LV-290 will vector cut a circle around the initial position of the laser head. 

• SmartCENTER: The SmartCENTER function is a quick and easy way to precisely locate the center 

point between two points or four points.  

 

 

Tip 

The SmartCENTER function is a quick and easy way to precisely locate the center point between 

two points or four points. It is a great tool for users whose jobs often require engraving on 

specific locations such as on award signs and plaques. 

 

Tip 

It is highly recommended you enable the red dot laser pointer when setting / adjusting the 

Position Modes, as this will ease your job positioning with enhanced accuracy. 
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Image Output Direction (Advanced Page) [DEFAULT SETTING: Top to Bottom] 

These selections allow you to control the direction in which the system processes an engraved image. 

 

• Top to Bottom: Selecting this will force the system to process the current task by moving the lens 

carriage from the top to the bottom of the image (rear end to front end of the work table). 

• Bottom to Top: Selecting this will force the system to process the current task by moving the lens 

carriage from the bottom to the top of the image (front end to rear end of the work table) 

 

Normally, the LV-290 engraves from left to right, top to bottom. Selecting Bottom Up will alter the 

engraving sequence and the engraving will start from the bottom and work its way to the rear of the 

working table. 

 

Tip 

In situations where the material you will be working with may produce a lot of dust byproducts 

and you are utilizing the optional air extraction system, it is recommended that you select the 

Bottom To Top image output direction option. This will minimize the amount of dust 

byproducts lodged in the engraved sections as the air extraction system is vented from the rear 

of the machine, the same direction as the image is processed. 

 

Border (Advanced Page) [DEFAULT SETTING: Unselected] 

In cases where you are working with a negative image (negative outline areas of your image are 

engraved, rather than the positive areas), you may wish to include a border around your image. 

To properly add a border, you will first need to Invert your design from the Options Page, then check 

Use Border and specify a value for the thickness of the border you would like to add to your design. 

This mode is useful for engraving rubber stamps, as it allows you to create the outline around your 

stamp image. 

 

NOTE 

If you wish to use the Border and Cluster function simultaneously, the Border Thickness value 

must be less than the Distance value specified in the Cluster setting. 
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Vector Function (Advanced Page) [DEFAULT SETTING: Normal] 

• Normal: This selection will not apply any special advanced vector function to your job. This is the 

default Vector Function setting. 

• All Raster Output: This selection will instruct the print driver to process your entire image as a raster 

engraving. Any vector lines within the image will be treated as raster data and outputted as a raster 

engraving, similar to a dot-matrix printer. 

 

• Vector Sorting: When performing a vector cutting job in which your image has one vector cut area 

enclosed within another vector cut area, select the Vector Sorting mode. This mode will automatically 

instruct the print driver to process the inside vector image and moving outwards. If you try to process 

a vector image that has multiple layers without using this mode, what may occur is the laser engraver 

may process the outer vector cutting first, and any inner vector cutting will not be possible as your 

centerpiece material may have dropped to the cutting table. This setting will always automatically 

direct the laser to cut from the inner most vector shape and move outwards. 

• Inside out Cutting: This setting will always automatically direct the laser to cut from the inner most 

vector shape and move outwards. 

 

• Optimization Sorting: This is a setting that will minimize your process time. When selected, the print 

driver will analyze your image and automatically determine the most efficient processing path to 

process your image. 
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 Decal Cutting: this function is developing to reduce material weeding job after laser cutting for 

multiple layers adhesive materials, such as lettering vinyl, heat transfer film, and twill film. This 

function allows allocating different parameters for corresponding decal layer numbers to do die 

cut (cut through media) for the unwanted parts, and kiss-cut (half cut) for the kept material parts, 

after the laser cutting, users can just peel off the materials to get rid of waste parts.  

 

 

 

 

Enhanced Vector Mode (Advanced Page) [DEFAULT SETTING: Unselected] 

This setting allows you to improve the cutting quality at the expense of speed. Your engraving speed 

will be dropped by 50%, to maximize the cutting power. We recommend that you enable this function 

when cutting thicker materials. 

 

  

Decal layer No. 2:  

Die cutting pen (Cut through) 

Decal layer No.1:  

Kiss-cutting pen (half cut) 
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Drilling (Advanced Page) 

The drilling function is available only for use with AutoCad. Users can insert dots from AutoCad’s tool 

bar and use the drilling function to set the drilling time required to create holes. 

Use the default “point” tool ( ) from the tool bar to create dots which will be interpreted as drilling 

locations. 

Use the adjusting bar on under the “Drilling” function to set the drilling time (spot delay) required. The 

size of the drilled hole can be adjusted by deploying a longer or shorter drilling time. 

 

 

Use Cluster (Advanced Page) [DEFAULT SETTING: Unselected] 

This setting allows you to change how the LV-290 interprets and processes individual / independent 

areas of an image in order to minimize job-processing times. The Cluster function is only applicable 

when multiple areas of an image are broken down and isolated from each other (areas not touching 

each other, blank space in-between). Another condition that must be met for the Cluster function is 

that these individual areas of your design must have some X-axis overlap, meaning that they should be 

to some extent side-by-side with empty spaces between them. The distance value can be set by the 

user and represents the limit or cutoff point in which side-by-side objects will be processed in Cluster 

mode or not. If the distance between side-by-side objects is greater than the set distance value, then 

the individual areas will be processed in Cluster mode. Conversely, if the distance between side-by-side 

objects is lesser than the set distance value, then the individual areas will be processed normally (not 

via Cluster mode). 

An example of an image that would benefit from the Cluster function would be: 2 squares to be 

engraved, side-by-side on the X-axis with a 20 cm gap in between them. In this scenario, you would 

want to enable the Cluster setting and set the distance to a value less than 20. By doing so , the laser 

will completely process one square and “leap-frog” to the second square, rather than processing both 

squares simultaneously. The resulting processing time is minimized by eliminating the unnecessary 

travel distance the laser head needs to make across the X-axis in between squares, if they were to be 

processed simultaneously. 

 

NOTE 

If you wish to use the Border and Cluster function simultaneously, then the Border Thickness 

value must be less than the Distance value specified in the Cluster setting. 
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True Image Mode (Advance Page) [DEFAULT SETTING: Unselected] 

This setting allows you to improve the engraving quality by reordering the line by line output 

sequence and by doing so masking the banding problems. This feature is only suitable for engraving 

large sized graphics. Note: The overall working time will be increased. 

True Image is a function that will shuffle the normal engraving sequence to produces a nicer 

engraving output by reducing possible banding occurrences. 
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5.2.3.4 LV-290 Printer Driver >> Paper Page 

 

 

Paper Size (Paper Page) 

The paper size represents your total work area. Ensure that the paper size is never set greater than the 

working area. The X value represents the length and the Y value represents the width. 

 

  LV-290 

Working Area  

(with SmartVISION Pro CCD) 

21.6”x17.3” 

(550x440 mm) 

Working Area  

(without SmartVISION Pro CCD) 

25.1”x18.1” 

(640 x 460 mm) 

Extended Working Area* 29.1”x18.1” 

(740 x 460 mm) 

* when Extend option is checked in Paper Page 

 

NOTE 

When using the optional rotary attachment system and with the Rotary Fixture option 

checked, the X value represents the length of your working piece. The Y value will be 

changed to Diameter, which represents the diameter of your working piece (at the position 

you wish to engrave). 

 

Unit (Paper Page) [DEFAULT SETTING: Metric (mm)] 

Here you can set your preferred measurement standard in which you would like to use with the LV-290 

printer driver. You can choose between metric or imperial standards. 
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Image Tuning (Paper Page) [DEFAULT SETTING: 0] 

In the event that you are processing extremely fine and detailed designs requiring near- microscopic 

edge-to-edge precision, you will need to adjust the image tuning setting. To adjust this setting, we 

recommend that you engrave a small black square design as a sample and use a magnifying glass to 

view the engraved results. 

When you look at your engraved test square under a magnifying glass, you may notice the edges of 

your square may be slightly offset, with every consecutive engraved even or odd line protruding past 

the square’s ideal edge. This occurrence may occur on the left or right side of the square and can be 

compensated for by the image tuning setting. In the diagram below, the arrows refer to the direction 

the laser head is moving to generate that engraved line. If the first and every other line protrude to the 

left of the square’s ideal edge, you will want to set the image tuning to a negative value. If the first and 

every other consecutive line protrude to the right of the square’s ideal edge, you will want to set the 

image tuning to a positive value. The further the protruding lines are from the square’s ideal edge, the 

larger you will need to set the Image Tuning value to compensate. 

 

 

The following is an example that has the proper image tuning, and demonstrates this significance when 

engraving fine, small, intricate text. The following two pictures show engraved text magnified with no 

image tuning (left picture) and image tuning enabled (right picture). 

 

 

  

Square’s Left Edge 
Square’s Right Edge 
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Extend (Paper Page) [DEFAULT SETTING: Unselected] 

If you are processing a very large area requiring the maximum work table area, you will want to enable 

this mode. Enabling this mode will extend the LV-290 maximum work area to 29" x 18" (740 mm x 460 

mm) from the default 25.197" x 18.110" (640 mm x 460 mm). This function is enabled at the expense of 

some quality loss, usually on the left and right edges of your full-size engraving. Usually the quality loss 

is minimal and may not be apparent, depending on your design. 

 

NOTE 

With the Extend function enabled, the following functions are disabled: 3D mode (Options 

Page), Stamp Mode (Options Page), SmartACT (Options Page), Disable Skip White 

(Advanced), Auto Focus (Pen Page), and Rotary Fixture (Paper Page). 

 

Rotary Fixture (Paper Page) [DEFAULT SETTING: Unselected] 

 

NOTE 

This option is only to be used with the Rotary Attachment optional accessory properly set up. 

For instructions on how to set up the Rotary Attachment, please refer to Chapter VII of this 

manual. 

 

You will need to select this option when processing a job with the optional rotary attachment system 

to engrave on round or cylindrical objects. When you have your material and rotary attachment properly 

set up: 

1) Check the Rotary Fixture function and notice the change in the Paper Size fields under Paper Size, 

the X value represents the length of your work piece. Enter the length of your work piece in this 

field. 

2) Under Paper Size, the Diameter value represents the diameter of your working piece (at the 

position you wish to engrave). Enter the diameter of your work piece in this field. Again, remember 

the proper diameter value would be the diameter location, at the point of engraving on your work 

piece. 

3) Under Rotary Parameter, the Offset value represents distance from the open end of your work 

piece to the base of the padded rubber wheel. This value will be displayed on the LCD panel. Enter 

the proper offset value in this field. 
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5.2.3.5 LV-290 Printer Driver >> Language Page 

This page allows you to specify the language displayed by the LV-290 Printer Driver. Current language 

options allow for: English, Spanish, French, Chinese (Simplified, Traditional), Japanese, and German. 

Remember to select “Save to Default” on Options Page to save the specified language. 
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5.2.3.6 LV-290 Printer Driver >> Raster Page 

 

NOTE 

The Raster Page is only available when Black & White Mode Setting is selected from the 

Options Page, this page offers a number of advanced Raster Engraving output options. 

 

 

 

Contrast (Raster Page) [DEFAULT SETTING: 0] 

This provides a quick and easy way to immediately adjust the contrast of an engraved image. Moving 

the slider to the Dark setting will increase the contrast levels of the engraved output, whereas moving 

the slider to the Light setting will decrease the contrast levels of the engraved output. 

 

Tip 

There are other ways to adjust an engraved image’s contrast such as: adjust the power / speed 

settings or simply adjust the contrast of the image in software with the graphic software 

application. 
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Halftone (Raster Page) [DEFAULT SETTING: Dithering] 

This option controls the way a raster-engraved image is processed. The “digital image to engraved output” 

process can be processed via two methods: Dithering or Error Diffusion. Each offer additional output 

options yielding different output effects, style, and quality. 

• Dithering: Interprets and outputs the raster engraving via the dithering method. This mode will allow you 

to select the Pattern Type and Dithering Matrix, and Enhanced Dithering. 

- Pattern Type: Dot, Bayer, Corner, 45 Degree [DEFAULT SETTING: Dot] 

Each pattern type uses a different shape and arrangement of dots to compose the shading 

effect of a raster image. 

The following diagram is an example of the raster effects when using the different pattern 

types. 

 

- Dithering Matrix: Variable depending on the Pattern Type selected. [DEFAULT SETTING: 8x8] 

This controls the resolution (dot size) and the number of dots the image is broken down into 

for the dithering process. As an example, selecting 2 x 2 will shade with a 5-grade halftone, 

where as an 8 x 8 Dithering Matrix will dither with a 65-grade halftone. 

The following diagram is an example of the raster effects when using the different dithering 

matrices. 

 

- Enhance Dithering [DEFAULT SETTING: Unselected] 

Selecting this will produce a finer dithering output. 

- Error Diffusion (Raster Page): Interprets and outputs the raster engraving via the error diffusion 

method. This mode will allow you to select from three diffusion types: Floyd, Stucki, and Jarvis. 

- Diffusion Type: Floyd, Stucki, Jarvis [DEFAULT SETTING: Floyd] 

Each diffusion type presents the shade of image as different spread halftones instead of dots 

to compose a raster image. 

The following diagram is an example of the raster effects when using the different diffusion 

types. 
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Tip 

There is no “correct” or “best” setting when using the Raster options. The most appropriate 

settings will be based on a variety of factors: your design, the material you are engraving on, 

and the results you wish to achieve, etc. Please take some time to experiment with the 

multitude of raster options to get the one you feel is the best for your piece. This is where 

much of the fun in engraving is….experimentation! 
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5.2.3.7 LV-290 Printer Driver >> Stamp Page 

Producing stamps require different operational steps than your standard engraving or cutting jobs. The 

Stamp page offers dynamic options allowing you to customize your stamp production process.  

 

NOTE 

The Stamp page will only appear and be accessible when you have selected the Stamp Mode 

from the Options Page. 

 

Tip 

Functions located on the other pages that are useful when making a stamp: Set Shoulder, Pitch, 

Border, Invert, and Mirror. 

 

 

 

Pitch (Stamp Page) 

Your stamp will be a reversed image composed of engraved depressions and ridges. Think of these 

ridges as the “contact sections” of the stamp. If the ridges of these contact sections are too thin, they 

may break. The Pitch setting allows you to increase the width of the ridge base, hence creating more 

stable “contact sections” and longer lasting stamp. The pitch value setting allows you to adjust the base 

width of the ridge. Broad pitch gives the maximum amount of support for each ridge. Experiment with 

different pitch value settings in order to produce the stamp that is best suited for your application.  

 

  

Bridge: contact area of the 

stamp 

Base of bridge (pitch) 

Slope of bridge (shoulder level) 
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Adjustment Bar/ Power Level (Stamp Page) 

Another important aspect of creating a stamp is setting the slope level of the shoulder. The shoulder is 

the section from the “contact section” of the stamp to its base. This function allows you to adjust the 

slope for the shoulder sections of your stamp. By sliding the sliders or directly input of power levels, 

you will be able to change the slope of the shoulder. 

 

NOTE 

The visual representations of the Pitch and Shoulder Levels in the LV-290 driver are an 

exaggerated representation to allow for easy visual guidance and precise input. Remember 

we are working with distances less than 1 mm here. 
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5.3 SmartCONTROL Vision 

5.3.1 SmartCONTROL Vision Introduction 

Reminder Window 
In order to avoid transmission collisions, each time you launch the SmartCONTROLTM software, it will show a 

reminding message that shut down SmartCONTROLTM first if you want to print files through other graphic 

software to laser machine. Click “OK” to open SmartCONTROLTM software. 

 

Welcome Window 
This welcome window will allow you to quickly open historic files or begin a brand new job. 

 

If you would like to disable this opening window next time you start SmartCONTROLTM, please go to 

File→Option→System→Welcome and cancel the check on “Enable the Welcome Dialog”. 
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Main Window 
The Main Window of SmartCONTROLTM software is divided into several unique sections: The Menu Bar, the 

Tool Box, the Work Area, and the Property Table. 

 

 

 

 

 

 

 

 

 
 

 

 

Menu Bar 
Similar to many Windows TM based program, the Menu Bar contains the locations of almost all the functions 

of the SmartCONTROLTM Software. They are sorted into the following categories: 

➢ File Menu 

➢ Output Menu 

➢ Edit Menu 

➢ Draw Menu 

➢ Image Menu 

➢ Color Menu 

➢ Vision Menu 

➢ View Menu 

➢ Window Menu 

➢ Help Menu 

More information regarding the different Menus will be provided in the following sections. 

 

  

Property Table 

Object Browser Work Area 

Menu Bar 

Tool Box 
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Tool Box 
The default Tool Box is composed of the Standard Bar, the Properties Bar, the Draw Bar, the Font Bar, and 

the Edit Bar. These bars provide visual references for the most commonly used tools. More information 

regarding different tools would be present in the VIEW MENU section. 

 

Work Area 
The Work Area is where graphics placed to create a file. The area can be enlarged or decreased to equal the 

size of the materials that are to be engraved or cutting. 

 

Property Table 
All objects created or imported on the Work Area have their own unique sets of properties.  These 

properties define how each specific object of groups of objects are displayed on the Work Area or marked 

by SmartCONTROLTM. To display the properties of an object or a group, simply highlight it and the specific 

property details should reveal themselves on the Property Table. If the Property Table is not currently active, 

choose the object and press the right mouse button to choose Property Table. 

 

NOTE 

After you have edited one of the parameters in the Property Table, click on Apply or Apply to 

All in order to insert your changes. 

 

Object Browser 
The Object Browser would show an OBJECT BROWSER Window in the left side, and list all the objects you 

create on the working area, you can identify the object format, create sequence, name the object and select 

objects by clicking it in the OBJECT BROWSER Window. The objects shown in the upper level means its 

output sequence. 

 

 

Exit 

Close SmartCONTROLTM 
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5.3.2 SmartCONTROL Vision Output Function 

Output Function is to set up laser parameters and output graphic to laser machine. The function can be 

accessed through Menu Bar as indicated below. 

 

 

Processed Condition Setup 

Set the engraving output parameters such as pen parameters, page setting and output mode by selecting 

Processed Condition Setup under Output function. 
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➢ Pen parameters 

 

SmartCONTROLTM provides 16 color pens, and each pen presents laser parameter setting, once colors 

are set, the pen would refer to the specified parameters when you apply the colors to an output. Pen 

Parameters under Processed Condition Setup would enable you to adjust the power, speed of each 

color pen. 

(1) Choose a color pen 

(2) Adjust the bar next to speed, power and PPI for the chosen color pen 

Remark: 

1. Speed 

The speed is calculated by percentage, which means some percentage of the max. Speed of the 

indicated laser engraver. 

2. Power 

The power is calculated by percentage, which means some percentage of the max laser power that 

the indicated laser engraver has. 

3. PPI 

PPI (pulses-per-inch) represents the number of times the laser pulses (fires) per linear inch, 

exclusive for vector cutting. Higher PPI settings will generate deeper, overlapping laser pulses, 

resulting in cleaner cuts. Lower PPI settings (lower than 150) will result in the individual laser 

pulses being spread apart, resulting in a perforated effect (similar to the perforation in the 

paper between mailing stamps). 

4. Air 

This checkbox controls the SmartAIR air-assist function (if you have the optional air compressor 

installed). By selecting a pen color and checking this box will enable the SmartAIR air-assist 

function for that particular pen color. As an example, if you are performing a combination of 

both surface raster engraving job and deep vector cutting on a material such as acrylic, you 

may want to enable the SmartAIR air-assist for the vector cutting sections to get the cleanest 

cuts. To do this, you would simply need to select the pen color that you have assigned to the 

sections to be cut and select the Air checkbox for those particular pen colors. 
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➢ Page Setting 

 

Set the page parameters, including output page size, Resolution, Rotary Attachment. 

(1) Machine setting 

Set the size of machine. It will be the working area. 

 

 

➢ Output Mode 
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(1) Mode 

You can select from four primary mode settings, depending on your application or results you 

would like to achieve. 

 

 Black & White mode 

Select this mode when using clipart images or drawings with several colors, shades of gray, 

or many outlines. This mode outputs in a method similar to that of a black and white laser 

printer. This machine will interpret colored and shaded areas as 256-level shades of gray by 

producing a halftone effect while engraving. Instead of engraving only solid lines, gray or 

halftone areas will be a collection of dots with varying density. 

The entire selected image will be engraved using a single set of power and speed settings 

(the black pen from the PEN menu. Please refer to the next section of the details regarding 

the PEN functions). The resolution and depth of these halftone areas can be adjusted with the 

DPI setting found on the Options page. Please note that selecting the Black & White mode 

will add a new Raster page to the menu. The Black & White mode dithering settings can be 

changed from the Raster page. (Please refer to the Raster section below for details) . 

Experiment with different dithering settings to attain the desired results. 

 

Tip 

The Black & White mode interprets the processed image by the varying colors and shades. For 

the best results, we suggest you convert the image to a grayscale image with your graphics 

software prior to engraving in the Black & White mode. 

 

 Manual color fill 

Select this mode when you would like to designate specific power and speed settings and 

link them to certain colors of your image. The LV-290 printer driver allows a maximum of 16 

pen parameters to be set. 

 

(2) Position 

These selections allow you to control the positioning of the laser head after each job 

completion and before the next subsequent job. 

 Home 

Sets the position of laser machine carriage corresponding to the origin (top left) position of the 

graphic software before and after processing each job. Therefore, the laser carriage will start a 

job from this home position and return to the home position after completed jobs. 

 

(3) SmartCONTROL Vision 

Check the SmartCONTROL Vision box to enable SmartCONTROL Vision function. More detailed 

setting of VISION function can be found in Chapter 5.3.3. 

 

Output Preview 

Users can use the Preview function to check a simulated output of the job. An estimated working time 

will also be shown. 
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Output 

 

The output box would show all the output setting, and you can press “Execute” to star t engraving or 

press Exit to close output and return to editing or output setting. 

(1) Output Select Objects Only 

Checking this will instruct the laser machine to prints the objects that you have selected. 

(2) Keep Mark Match Position 

Checking this will instruct the SmartCONTROLTM Vision used last time mark position to process job. 
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5.3.3 SmartCONTROL Vision Function 

Running the SmartCONTROLTM Vision 

1) Launch SmartCONTROLTM software program and click “New File” or “Open File” to open history file. 

 

2) Go to “Vision” in the Menu Bar and select “SmartCONTROL Vision”. 

 

3) Make sure connection status indicator shows green for both “USB Status” and “CCD Status” 
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NOTE 

If the connection status indicator shows red, please reconnect the two USB cables and make 

sure “USB Status” green light is on, and the “CCD Status” green light is blinking.  

    
▲ Successful Connection        ▲ Incorrect Connection 

Incorrect connection may cause the SmartVISIONTM PRO fail to work. 

 

 

SmartCONTROLTM Vision Main Window 

 

 

 

 

 

 

 

 

  

     V    W      

Arrows Key for 

CCD module 
Learned Mark Window 

SmartCONTROLTM Vision 

Function 

Connection 

status 

indicator 

signs 

Laser and CCD 

Module Position 

Laser ROI Frame  

(Blue Frame) 
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• SmartCONTROLTM Vision Function 

There are three functions of SmartCONTROLTM Vision, including CCD calibration, Mark Learning and 

Advance. 

• Live View Window 

Displaying the object read by SmartCONTROLTM Vision in real time. 

• Laser ROI Frame 

It allows user to choose the registration marks for learning, all the objects in the frame will be defined as 

mark. 

• Connection Status Indicator  

Allow user to check connection status between the SmartCONTROLTM Vision software and 

SmartVISIONTM Pro CCD.  

• Learned Mark Window 

Shows the graphic which has been memorized 

• Laser and CCD Module Position 

Shows the coordinate of the Laser and SmartVISIONTM Pro CCD module. 

• Arrows Key for CCD module 

To fine tune the position of the SmartVISIONTM Pro CCD module 

• Stop SmartCONTROL Vision 

Stop the operation of SmartCONTROLTM Vision 

 

SmartCONTROLTM Vision Function 

The SmartCONTROLTM Vision function is divided into several unique sections: the CCD Calibration, the 

Mark Learning and Advanced 

➢ CCD Calibration Tab 

 

CCD Calibration Tab allows user to accurately calibrate the position of CCD module and laser beam. 
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➢ Mark Learning Tab 

 

Mark Learning allows users to learn, save and load the marks. 

⚫ Mark Learning 

 

- Mark Mode 

Define using two, three or four-marks mode 

 

- Mark Number 

Assign a number to the mark SmartCONTROLTM Vision is about to learn. 
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- Start Learning 

Start to lean the marks. 

 

- Mark Size 

Set the registration mark size, and the laser ROI frame will auto adjust to the suitable size for 

best result. 

 

- Save Marks 

Save the marks which are learned. 

 

- Load Marks 

Load the marks which are saved. 

⚫ Match Criteria 

 

- Similarity (%) 

Define the range of similarity comparing with the original learned marks when 

SmartCONTROLTM Vision is reading or searching marks. 

 

- Angle (degree) 

Define the offset of angle variation comparing with the original learned mark when 

SmartCONTROLTM Vision is reading or searching marks. 

 

- Auto Searching 

When check Auto Searching function, the CCD module will automatically search the marks 

in near areas if the first attempt of marks searching is failed. 

⚫ Mark Verification 

 

Mark Verification helps to examine if the defined marks are easy to search for CCD module before 

starting the laser jobs. 

- Similarity (%) 

It allows users to verify the percentage of similarity between the reading mark and the learned 

mark. 

 

- Angle (degree) 

It allows users to verify the degree of angle between the reading mark and the learned mark. 

 

- Mark Match 

It allows users to verify if SmartCONTROLTM Vision can successfully match with the learned mark 

or not.  
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➢ Advanced Tab 

 

⚫ Array Copy function 

- Array Copy 

Check the box to enable the Array Copy function. 

 

- X Copy/ Y Copy 

Define the duplicated numbers of horizontal (X) and vertical (Y). 

 

- X Gap / Y Gap 

Define the graphics gap of horizontal (X) and vertical (Y). 

 

 

SmartCONTROLTM Vision Calibration 

Calibration function is aimed to fine-tune the position of the SmartVISION TM Pro CCD module and the laser 

beam. If high precision cutting is demanded, we recommend you to calibrate SmartVISION TM Pro first. 

 

1) Place the black calibration cardboard in the accessory kit on the working table of laser system. 

2) Press “AutoFocus” button of laser machine to automatically set the focal distance precisely. 

3) Go to SmartCONTROLTM and Click "Vision" on the menu and select “SmartCONTROL Vision” from pull-

down menu. 
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4) Click “CCD Calibration” tab and press the “Start Calibration” button. 

 

 

5) SmartCONTROLTM will show step by step instructions to guide you on how to do the calibration. 

 

6) Move the laser carriage to blank area and click OK. 

 

 

7) The laser machine will engrave a calibration mark. 
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8) Click “OK” to continue. 

 

 

9) Click “Mark Learning” tab and set the Mark Number as 0. (Mark 0 is special for CCD calibration use.) 

 

 

10) Use the mouse to move the laser ROI frame and make sure the frame crosshair is aimed at the center 

of the engraved calibration mark. 

     

  



 

                                          153                                  

11) Press “Start Learning” button, then the Learned Mark Window will show the memorized mark. 

 

12)  Click “CCD Calibration” tab and press the “Start Calibration” button again. 
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13) The message in step 3 will pop up, move the laser carriage to blank area and click OK. 

 

 

14) Laser will engrave a new calibration mark and calibrate automatically. After calibration is done, the 

crosshair of laser ROI frame will aim at center of calibration mark. 

 

 

15) The “Calibration completed” message will pop up indicating that calibration is completed. 
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Convert and Import File 

For the best output quality, we recommend you convert the graphic file to prn format via SmartCONTROLTM 

print driver from the graphics software (e.g. CorelDRAW or Illustrator). SmartCONTROLTM print driver will 

install to your computer automatically when you installed SmartCONTROLTM software. 

 

Before converting the graphic file, please make sure Color Management is disabled and the Page Size fits to 

SmartVISIONTM Pro CCD under graphic software.  

 

CorelDRAW Example (Color Management) 

The following is an example of how to properly disable Color Management in the graphics software. 

CorelDRAW is the designated graphics software used for this example. For other graphics software, 

you will need to access the corresponding Color Management page. 

1) From the primary menu, click Tools → Color Management → Default Settings… and 

CorelDRAW’s Default Color Management Settings will appear. 

2) Under the Present pull down menu, select Simulate Color Management Off. 

 

3) Click OK to complete the color management adjustments. 

 

From your graphic software’s Page Setup page: 

 

CorelDRAW Example (Page Setup and Orientation) 

The following is an example of how to set the Page Setup and Orientation in the graphics software. 

CorelDRAW is the designated graphics software used for this example. For another graphics 

software, you will need to access the corresponding Page Setup page. 

 

1) After the design is completed, click File → Print from the primary menu, then the print window 

will pop up. 

  

Choose the “Simulate Color 

Management Off” from graphics 

software to disable the color 

management. 
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2) Select your SmartCONTROL’s driver <SmartCONTROL-LV-290> from the printer list 

 

3) Click Apply and Cancel to close the print window. 

 

4) From the primary menu, click Layout → Page Setup, then the Options window will pop up. 
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5) Click the “Get page size from printer” button to fit SmartVISIONTM Pro CCD working area. 

 

 

Model Working area 

LV-290 with SmartVISIONTM Pro CCD 550mm x 440mm 

(21.6” x 17.3”) 

 

6) Click OK to end the paper size adjustment. 

 

Here we use CorelDraw as illustration of how to convert a file.  

1) Select all the designed objects and set the outline to hairline from tool bar in the graphics software. 

 

 

NOTE 

Under the Registration Mark Ready scenario, SmartCONTROLTM will automatically define the 

mark #2~#4. Make sure all the registration marks are the same type and filled before 

converting the graphic file to prn format. 

 

 

2) From the primary menu in graphics software, click File → Print… and the Print window will appear. 
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3) Click “Color” tab to make sure the “Output colors as:” set as RGB, and then click “OK” to continue. 

 

 

4) Click “OK” and Print To File window will appear 

 

 

5) Select the save folder and define file name, then click “Save” to convert 
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6) Close the graphics software (here is Corel Draw) and open the SmartCONTROLTM Software. 

 

7) Click “File” → “Field Setting…”, then the field setting window will pop up 

 

8) Click “Machine Setting” 
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9) Click “Follow Output Machine” to set the correct work area. 

 

 

10) Click OK to end the work area setting. 

 

 

11) Click “File” → “Import” 
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12) Select the converted file and click “Open” to import the saved file to SmartCONTROLTM 

 

 

13) File import is completed. 
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Operating SmartCONTROLTM Vision 

SmartCONTROLTM allows users to assign any graphic to be registration marks, at the meantime, if high 

precise cutting is required, we suggest you to use circle, square, crosshair or star as registration mark which 

we call it “Registration Mark Ready” scenario. 

 

 

 

NOTE 

• The recommended value for registration mark size is between 3mm-15mm. Marks in 

extreme dimension may affect the precision of CCD reading. 

• Under the Registration Mark Ready scenario, SmartCONTROLTM will automatically define 

the mark #2~#4. Make sure all the registration marks are the same type and filled 

before converting the graphic file to prn format. 

 

 

SmartCONTROLTM Vision Operation – Registration Mark Ready Scenario 

1) Place the printed object of the machine platform. 
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2) Click “AutoFocus” button of laser machine to automatically set the focal distance precisely. 

3) Open the file or import prn file. 

4) Click “Vision” on the menu bar and select “SmartCONTROL Vision” to launch the Vision operation 

window 

 

5) Go to the “Mark Learning” tab and select mark mode. The illustration is 4 marks mode. 

  

6) Input registration mark diameter/ dimension or line width value in the Mark Diameter / Line Width 

field. 

 

NOTE 

Please measure the diameter of the registration mark, and than input the mark size in the 

Mark Size field. 
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7) Move SmartVISIONTM Pro CCD module to read the first mark, and make sure the mark shown on 

the software screen. 

  

 

NOTE 

Following is the order of the mark #1 to mark #4. 

 

 

8) Use the mouse to move the laser ROI frame until the crosshair of the frame aims at the center of 

registration mark. 
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9) Click ”Start Learning” button and the Learned Mark Window will show the learned pattern. 

 

 

 

 

10) Click "Output" on menu bar and click "Processed Condition Setup" 

 

  

Mark Learned 

Window 
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11) Select machine from “Machine Mode” and set the processing parameter in “Pen Parameter” tab 

 

 

12) Click "Output" on menu bar and click "Output" 
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13) Check "Output Selected Objects Only" and the "Execute" button to start CCD reading and laser 

processing. 

 

 

NOTE 

When SmartCONTROLTM Vision is under processing, any emergency, press "STOP 

SmartCONTROL Vision" button to stop the CCD action immediately. 

 

 

14) SmartVISIONTM Pro CCD will automatically search for the registration marks and perform laser 

cutting jobs. 

 

15) First job is completed, place the next object to the machine platform. 
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16) Click “Execute” of Output window to process job. 

 

17) If there is an error with the placement, SmartCONTROLTM Vision may not find the marks correctly. 

"Pattern Match Failure" message will pop up, press "OK "button to continue. 

 

18) Move the carriage with red beam to the failed mark. 

 

19) Click “Execute” again, SmartCONTROLTM Vision will automatically calibrate the position and 

continue the job. 

 

NOTE 

If the object placement angle is too large, SmartCONTROLTM Vision may not source the 

marks. Repeat Step 17 ~ Step 19 operation. 
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SmartCONTROLTM Vision Operation – Define Marks from Graphic Scenario 

Sometimes the printed objects may not include registration marks like circle, square, cross, or star for 

CCD reading, SmartVISIONTM Pro CCD present a substitute solution for it. 

 

1) Place the printed object on the machine platform. 

 

2) Click “AutoFocus” button of laser machine to automatically set the focal distance precisely. 

 

3) Open the converted prn file or import prn file 

 

4) Select the “Vertex” tool from tool bar 
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5) Move the mouse cursor to where you want to learn as registration mark and left click the mouse 

button, a vertex will be added on the object. 

 

 

6) Click “Vision” on the menu bar and select “Mark 1 Definition,” a check on the Mark 1 Definition will 

be shown. 

 

7) Repeat Step 5 to Step 6 to complete all mark definition settings. 

 

  

Mark 1 

Definition 

Mark4 

Definition 

Mark 2 

Definition 

Mark 3 

Definition 
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8) Click “Vision” on the menu bar and select “SmartCONTROL Vision.” 

 

 

9) Go to the “Mark Learning” tab and select mark mode. The illustration here is 4 marks mode.  

 

 

10) Input mark size value in the Mark Size field. When the mark is defined as part of the graphic, it is 

recommended to set the mark size as 3mm~15mm to get best reading results. 
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11) Move the SmartVISIONTM Pro CCD module to the first marks till it’s shown on the live window. 

 

 

12) Use the mouse to move the laser ROI frame and ensure the crosshair of the frame aims at the 

defined mark. 

 

 

13) Click ”Start Learning” button and the Learned Mark Window will show the learned pattern. 

 

 

  

Mark Learned Window 
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NOTE 

In order to improve the success rate of CCD reading, it is recommended that the defined 

mark to be high contrast selection. 

Example: 

 

 

 

14) Repeat Step 11 to Step 13 to complete the 2 ~ 4 marks learning. 

 

15) Click "Output" on menu bar and click "Processed Condition Setup" 

 

 

  

OK 

NG 
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16) Select machine from “Machine Mode” and set the laser processing parameter in “Pen Parameter” 

tab 

 

17) Click "Output" on menu bar and click "Output". 

 

18) Check "Output Selected Objects Only" and the "Execute" button to start CCD reading and laser 

processing. 
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NOTE 

When SmartCONTROLTM Vision is under processing, any emergency, press "STOP 

SmartCONTROL Vision" button to stop the CCD action immediately. 

 

 

19) SmartVISIONTM Pro CCD will automatically search for the registration marks and perform laser 

cutting job. 

 

20) Processing completed, place the next object on the platform. 

 

21) Click “Execute” to process second job. 
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22) If there is an error with the material placement, SmartCONTROLTM Vision may not be read 

correctly. "Pattern Match Failure" message will pop up, press the "OK "button to continue. 

 

23) Move the carriage with red beam to the failed mark. 

 

24) Click “Execute” again, SmartCONTROLTM Vision will automatically calibrate the position and 

continues the job. 

 

NOTE 

If the printed object placement angle is too large, SmartCONTROLTM Vision may fail to read 

the marks. Repeat Step 22 ~ Step 24. 

 

Array Copy Function 

When the design graphic is repeatable and is arranged in matrix, you can only have CCD to learn one 

set of registration marks for all the graphics by using Array Copy function. 
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1) Place the printed object on the machine platform 

 

2) Click “AutoFocus” button of laser machine to automatically set the focal distance precisely. 

3) Open the file or import prn file. 

 

4) Follow “Operating SmartCONTROLTM Vision” step. 4 ~ step. 15 to define, learn, and read registration 

marks. 
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5) Click "Advanced" tab. 

 

6) Check Array Copy box and enter the matrix numbers of the X and Y copy. 

 

7) Enter the gap value of X and Y. Gap is defined as the distance from image to image shown in below. 
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NOTE 

The following picture shows the laser working path for graphics with Array Copy function. 

Please learn marks from lower left corner graphic. 

 

 

 

 

 

8) Follow “Operating SmartCONTROLTM Vision” step. 10 ~ step. 15 will automatically move, read marks 

and processing job. 

 

Learn mark from the lower 

left corner graphic. 
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Chapter 6 Engraving and Cutting 

Techniques 
 

 

Raster Engraving 

Vector Cutting 

Vector and Raster 

3D Tips 

Modify Image Setting of a Picture for Better 

Engraving Quality 
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6.1 Raster Engraving 

A CO2 laser engraver can process text, scanned image, digital picture, or design by “laser firing” grids 

/dots of individual pixels into a raster image. Think of this as simply “printing” your job onto any particular 

material. An example of a raster engraved piece would be a photo engraving on tile, as shown in the picture 

below. 

 

6.2 Vector Cutting 

A CO2 laser engraver can process text, design, and images composed of lines through continuous-firing 

of the laser to cut out various shapes. When performing vector cutting operations, imagine the laser head 

as a pair of scissors cutting out the lines specified in your design. An example of a vector cut piece would 

be a customized dining mat, as shown in the picture below. 

 

The LV-290 Printer Driver determines which sections should be raster engraved or vector cut based on 

the outline width of that particular area or section of the design. In order to prep a particular section for 

vector cutting, you will need to set that object’s fill color to white and set its outline thickness between 

0.001" (0.025 mm) to 0.004" (0.1 mm) via the graphics software. 
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Below is an example of how to prep an area (in this case, we will use a section of text) for vector cutting. 

CorelDRAW will be used as the selected graphics software. 

1) With the text function, create a string of characters and select those characters by clicking on the 
text. 

2) Change the text fill color of the selected characters to white by left clicking on the white color 
from the CorelDRAW Color Palette (located on the right hand side of the screen) 

3) Change the outline color of the selected characters outline by right clicking on the desired color 
from the CorelDRAW Color Palette. 

4) Change the selected characters outline thickness to the thinnest width by right clicking on the 
selected text select <Properties> → Click on the <Outline> tab and change the Width to its 
thinnest dimension. Click on “OK” to apply the changes. 

5) Now your string of characters has been properly designated as an area to be vector cut. Simply 
“print” your job (output the file to the LV-290) and watch as your string of characters is vector 
cut. 

6.3 Vector and Raster 

In some cases, you will want to process both raster engraving and vector cutting tasks within a single 

project. For example, if you wanted to engrave a design onto a particular material and then cut a 

particular shape around that engraving. The picture below is an example of engraving on a piece of 

leather which has then been cut out: The picture below is an example of an engraving on a piece of cork, 

which has then been cut out with a square shape: 

 

In these situations when there are raster engraving and vector cutting operations on a single project, the 

printer driver will interpret between raster sections and vector sections by the types of lines and line 

widths of your design. Areas of your design with line widths set between 0.001" (0.025 mm), 0.004" (0.1 

mm) will be designated for vector cutting, and the other areas will be designated for raster engraving. 
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6.4 3D Tips 
3D Mode is one of the functions of this laser engraver. Instead of traditional two dimensional graphic 

processing, 3D Mode allows the naked eyes to visualize the curvatures of the 3D effect by applying 200 power 

levels technology to create different depth of engraving. Although it is easy to produce 3D samples with this 

Engraver, production of the 3D graphic can be a hassle for our users. 

 

Principle for 3D production by laser 

3D processing uses degrees of the gray level to adjust the output energy of the laser. Take the figures below 

as an example. When the color of a certain block is set as 100% black, the laser output energy for processing 

will be at 100%. The processing depth will be fairly deep. When the gray level is set as 50% black, the laser 

output energy will be adjusted to a smaller value accordingly so that the processing depth is not as deep. 

By specifying the degrees of the gray level in this way, various energy output is achieved, and the 3D effects 

are produced. 

 

By specifying different levels of black in design software, the corresponding laser power energy will 

generate different depths of engraving result. 

 

Introduction to software for 3D graphic production 

Many ways to produce 3D graphics are available. If you are familiar with or frequently use one of the 3D 

software in the market like Laser Type, EngraveLab, 3D Studio etc., you may use it for the production of 3D 

graphics. After completion, save the 3D images as one of the formats that is compatible with the Laser 

Engraver (such as JPG or BMP) and let the machine begin the engraving. If you are not familiar with any 3D 

software, some editing software specific for laser in the market also have 3D mode functionality, which could 

be a handy tool for you to produce 3D objects. Of course, you may also use Photoshop or CorelDRAW, which 

you might be using on daily basis, for the production of 3D objects. Ways to produce 3D graphics with these 

software are not the same. In the following section, we will give you simple illustrations with respect to how 

these software work. 
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Laser Professional AP 

Currently, quite few laser professional application softwares like Laser Type, 3D studio, EngraveLab are 

available in the market. You can not only create all kinds of vector images with these AP but also convert 

these vector images into 3D module, which is a great way to produce 3D graphics. 

As illustrated in the figure below, all you need to do is to choose the direction of the vector and then set the 

length and shape of the convex or concave surface. The software will automatically generate the 3D graphic 

for you. 

 

Concept illustration of 3D graphic production with Laser Professional AP 

 

After the graphic is completed, you can output the 3D graphic directly to the laser machine through THIS 

MACHINE driver, which is very handy. Or you can also export the 3D graphics as JPG or BMP format and edit 

with frequently used CorelDRAW or Illustrator software, then output the graphic to THIS MACHINE laser 

system. 

 

Photoshop & CorelDRAW 

The way to produce 3D graphics with Photoshop and CorelDRAW is very similar. Fill in the desired gray level 

colors to each of the drawn figures and proceed with further arrangement and combination. Then you may 

output the 3D graphic to the laser for the production of the 3D object. Take the figure below as an example. 

After producing two graphs in gray level, proceed with the arrangement and combination. Then you may let 

the laser proceed with 3D mode. 

 

Both Photoshop and CorelDRAW may produce 3D graphics in the manner of combination. 
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A way to produce 3D graphics 

For the production of 3D graphics, in addition to the requirement of having great familiarity with the software, 

a significant amount of time is required to design and arrange the layout. Thus, we use a relatively simple 

graphic for illustration so that you would understand how to produce 3D graphics better. 

 

Take the graphic above as a production example. CorelDRAW is used for the production of the 3D graphic. 

 

Step 1. Produce the gray level background 
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This machine requests your attention 

If you need to produce circular 3D graphics, you only need to select Radial as the gray level type in the pull-

down menu of Type. Then, a circular 3D graphic may be produced. 

 

 

 

Step 2. Produce three-dimensional characters 
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Step 3. Combine the 3D images 

After finishing the production for each of the objects, you may proceed with the combination of the 

objects. The combined graphic may be output with the laser engraver. 

 

 

Output the 3D graphic 
After selecting the graphic to be output, set the Mode as 3D Mode in the driver. After setting the engraving 

parameters, output the 3D graphic. 

 

 

Tips for engraving 3D graphics 

Application Lab provides a few reminders that may require your attention during the 3D engraving in order to 

improve the result of the engraving. 

Turn on the Air Assist function 

When the engraving is done along with Air Assist, the depth of the engraving would be deeper. Set Air assist 

inside the driver by checking the box. 
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Polish 

Dust will accumulate during the engraving when acrylic is engraved. The acrylic may be polished with Polish 

after the engraving. After the processing, don’t remove the engraved object. Use the Control Panel to lower 

the platform (for about 7~8 mm) and then engrave once again to achieve the better finish. 

 

After engraving the wooden objects, please use a toothbrush with some clean water to remove the dust on 

top of the object. 
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6.5 Modify Image Settings of Picture for Better 
Engraving Quality 

1. Connect your digital camera to the computer by USB cable. 

2. Download the picture from the digital camera to the computer 

3. Select the picture that you want to engrave.  

4. Import the image from the folder where the picture is located by selecting File/Import 

 

5. Convert the image to Bitmap by selecting the image and click on Bitmaps/Convert to Bitmap 
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6. Change the Bitmap settings by setting “Color” to Grayscale (8-bit) and “Resolution” to 300 dpi 

and click OK. 

 

7. Finally, Invert the image by selecting Effects/Transform/Invert 
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8. Now you are ready to output the modified image by clicking File/Print 

 

 

NOTE 

This instruction is a simple example for general use. There are many tips and tricks to achieve 

a good engraving quality. It takes a lot of practice and experience to achieve a good 

engraving quality. Different picture may need different modifications and different material 

may need different parameters. 
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Chapter 7 Optional Items 
 

 

Fume Extraction Unit Option 

Air Compressor Option Items 

Focus Lens Option 
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Several optional items are available to enhance your experience with this machine. If anytime after the 

purchase of your machine, should you ever consider to purchase any optional item, please contact your 

authorized Roland DG Corporation dealer. 

 

7.1 Fume Extraction Unit  

To properly remove dust, vaporized materials and chemical smoke from the working area and machine, it 

is necessary to install a suitable air extraction system. The air extraction system and other components 

are readily available from your authorized Roland DG Corporation dealer, or you can elect to purchase and 

install one yourself with components found at your local industrial supply store. 

 

LV-290's Fume Extraction Units are specifically designed to prevent personnel from inhaling hazardous 

fumes and dust generated by the laser process. Available for all LV-290 engravers, the Fume Extraction 

Unit represents the latest in exhaust extraction and odor reduction technology for all types of 

applications. Quiet operation, high vacuum capacity, compact design and long life expectancy are but a 

few outstanding features.  Each LV-290 Fume Extraction Unit is powered by a maintenance-free, 

continuous-running turbine. In order to ensure personnel safety and legal compliance, the LV-290 Fume 

Extraction Unit is CE-compliant for Europe. To purchase a LV-290 Fume Extraction Unit, contact your 

authorized Roland DG Corporation dealer. 

 

INSTALLATION (Self-Assembled Unit): 

1) If you purchase an exhaust system at your local industrial supply store, we suggest that you have a 

contractor install the exhaust system. We highly recommend you to install the exhaust system 

outside of the building for both noise considerations and if it does not possess filtering capabilities. 

2) Mount the fume ventilation system in an obvious and accessible location, not too far from this 

machine, so it can be routinely switched on prior to laser engraving. The maximal distance you 

should mount the exhaust system away from this machine depends on the blower’s vacuum 

capacity. We recommend that you consult with the vendor regarding the unit’s vacuum force, 

maximal distances, based on the available models. 

3) Connect rigid and smooth walled tubing such as PVC or sheet metal with a 4” diameter to the 

ventilation opening located on the rear side of this machine. (As shown in the picture below). Try to 

keep this tubing as straight as possible as bends reduce the exhaust efficiency. Use the appropriately 

sized tube clamps and sealants to ensure a tight and secure attachment. 

4)  There are two exhaust openings on the rear side of this machine, you can connect the top or bottom 

one, or both for application requirements. The top ductwork is suitable for dust, smoke generated 

on material surface when doing laser engraving, which will reduce residue left on material surface; 

while the bottom ductwork is recommended for laser cutting jobs. Optimum down vacuum is critical 

for clear cutting edge when laser cutting materials. 
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Plugs 

7.2 Air Compressor 

Specifically designed for laser engravers, the air compressor utilizes an oil-free diaphragm. The air 

compressor helps to eliminate harmful and potentially damaging moisture from the laser optics, maximizing 

life of the laser optics. In addition, the air compressor provides an optimal air flow to the SmartAIR nozzles 

to minimize flaming, suppress working temperatures, and blow away dust and particle by products 

generated from the laser process. This machine provides an air control by pen color function in Windows 

driver to enable or disable air assist automatically per different pen jobs. Refer to Chapter 5.2.4.2 about driver 

operation in pen page.  

 

 
 
 
 
 

INSTALLATION: 

1) Remove the plugs on the air compressor to expose the air inlets. 

2) Fasten the included air tube fastener valve to the outgoing air inlet (indicated by 2a) and the air 

filter into the ingoing air inlet (indicated by 2b). 

 

1/4” A                
      C    A 

      C      

2b 

2a 
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3) Connect a 1/4" tubing to the air tube fastener valve on the air compressor. 

 

NOTE 

It is important that the ¼" air tubing has clean, straight cuts on each end. Jagged or slanted 

cuts will not produce adequate sealing capabilities. 

 
4) Open the bottom front doors of this machine to locate both the Air-Assist 

Valve and Internal Power Sockets. As indicated below: 

 

 

 

5) Plug the air compressor’s power cord A into the AC internal power socket. 

 

6) Plug the female end of power cord B to the AC internal power socket and the male end to an external 

power outlet. 
 

 

 

  

Air Assist Valve located at 

bottom right side for 100W 

models 

Air Assist Valve 

AC Internal Power 

Sockets 

Power Cord A Socket 

Power Cord B Socket 



 

                                          198                                  

7) Take the unattached end of the ¼" air tubing (other end already connected to air compressor) and 
connect it to the air tube connector on the air assist valve. Make sure you press down on the air 
tube fastener when inserting the ¼" air tubing, to form a tight, secure attachment as indicated in 
the diagram below. 

Air Flow Regulator 

 

 

 

 

8) Congratulations, you have finished setting up the air compressor. Make sure you have the proper 

SmartAIR nozzle installed (depending on your application), before you turn on and utilize the air 

compressor. 

 

 

OPERATION: 

Switch on the air compressor unit and make sure that the airflow regulator on the air assist value is opened 

(turn clockwise to increase the airflow, counter-clockwise to decrease the airflow). The air nozzle under the 

laser head should emit a steady flow of air. 

 

With the SmartAIR nozzle and air compressor properly installed and operating, all configurations and 

settings relating to air-assist functions are controlled through the LV-290 printer driver and hardware 

control panel.  Please refer to the LV-290 PEN page on print driver section of this manual for details on 

how to enable and configure air-assist functionality.  

 

 

 

Turn Clockwise to 

increase airflow 

Turn Counter- 

Clockwise to 

decrease 

Air Tube Fastener 

Air Tube Connector 
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7.3 Focus Lens Options 
7.3.1 CO2 Laser Focus Lens  

Roland DG Cop. offers four different focal lenses namely the 1.5”, 2.0”, 2.5”, and 4.0” for different 

applications.  The number description, 1.5”, 2.0”, 2.5”, and 4.0” signifies the distance of where passed through 

beam will converge.  For example, when a laser beam passes through a 2.0” focus lens, the beam will 

converge at a 2.0” distance resulting in a concentration of energy at that spot. 

The resulting spot size from the different focus lens are also different and the following chart shows the 

different spot sizes achieved from the different lenses. 

 1.5” Lens: The 1.5” lens is best when used for engraving of very fine details 

 2.0” & 2.5“ Lens: The 2.0” & 2.5“ lenses are good for normal engraving and cutting of up to 10mm 

thick acrylic. 

 4.0” Lens: The 4.0” lens is good for 10mm and above acrylic cutting. 

 

 

Engraving effects achieved with the different lenses 

 

  

Unscrew the three thumb screws on lens 

carriage to remove the carriage panel. 

Take out the lens carriage and insert the 

optional one for different applications. 

Thumbscrew 
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Cutting edges achieved with the different lenses 
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Chapter 8 Basic Maintenance 
 

 

Suggested Cleaning and Maintenance Supplies 

Maintaining the Work table and Motion System 
- Accessing the Work table and Motion System 

- Cleaning the Work table and Motion System 

- Lubrication of the Y Rails 

Cleaning the Optics System 
- Removing the Mirrors 

- Cleaning the Mirrors 

- Removing and Cleaning the Focal Lens 
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Keeping your machine clean and well maintained will ensure quality output, consistent reliability, and 

extended product life. Smoke, dust or residue build-up inside the laser system or the mechanical 

components can cause a reduction in the laser power, irregularities in the motion system, reduced product 

life cycle, and a host of other avoidable problems. This section will cover how to perform regular 

maintenance on the work table, motion system, mirrors, and focal lens. 

The frequency of the cleaning schedule will depend on number of variables such as the types of material 

you work with, the immediate work environment, the frequency of use, the quality of the exhaust system, 

etc. 
 

 WARNING 

• Electrical shock may occur if you do not turn off and unplug this machine before cleaning. 

• Damage may occur to the system if you do not turn off and unplug this machine before 

cleaning. 

• Always turn off and unplug this machine before cleaning! 

 

8.1 Suggested Cleaning and Maintenance Supplies 

Cleaning / Maintenance Tool Special notes 

Soap Solution or All-Purpose Cleaner  

Paper Towels  

Cotton Cloth  

Denatured Alcohol DO NOT use alcohol on any painted surface, plastic, or the 

laser system. 

Acetone ONLY to be used on the work table 

Vacuum Cleaner with a Flexible Nozzle Only to be used in and around the work table and motion 

system 

Cotton Swabs Supplied 

Lens Cleaner Supplied 1pc. Local supply is suggested. * 

Lint Free Lens Tissue Supplied 

#2 Phillips Screwdriver  

Allen Wrench .050”  
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8.2 Maintaining the Work table and Motion System 
8.2.1 Accessing the Work Table and Motion System 

It will be important to gain full access to the work table and motion system to properly clean and maintain 

these areas. To do so, you will need to lift the SmartLID. You can do this via the following steps:  

Opening the SmartLID: 

1) The top lid of the machine can be lifted open by using the handles from the rear side. Lift the lid to 
the maximum (indicated by a small click) to engage the latch (as shown in the picture below). 

 

2) Manually lock the SmartLID via the two sliding locks found on each side of the metal support rails 
by sliding them to the locked position (as shown in the picture below). 

 

 WARNING 

Anytime you have the SmartLID open, always make sure you have properly engaged the 

SmartLID manual locks on both sides of the metal support rails. Failure to do so may pose a 

serious risk if the SmartLID slams down. 

Closing the SmartLID: 

To properly close the SmartLID after you have finished accessing the work table or motion system, please 

follow these steps: 

1) Disengage both of the sliding locks found on each side of the metal support rails by sliding them 
away from you and into the unlock position. 

2) Push the SmartLID away from you and move to the maximum position to disengage the latch 
(indicated by a small click) and gently close the SmartLID.  

SmartLID Sliding Lock 
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8.2.2 Cleaning the Work Table and Motion System 

Clean the working table and the motion system on a frequent basis through the following steps:  

1) Turn the power off and unplug this machine before cleaning. 

2) Use a vacuum cleaner with a flexible nozzle to remove dust and debris from the work table and motion 
system. 

3) Apply small amounts of all-purpose cleaner, alcohol, or acetone to a paper or cotton towel to clean the 
working table. 

4) Apply a soap solution, all-purpose cleaner, or alcohol to a paper or cotton towel to wipe down the rails 
of the motion system. 

5) Wait for all cleaning residue to dry completely before plugging in and operating this machine.  

 

 CAUTION 

• Never pour or spray alcohol or acetone directly to the working table. 

• Oil, alcohol and acetone can cause fires or smoke build-up if improperly used. 

 

Tip 

Please clean the AutoFocus pin each time after completing the engraved job to make sure the 

AutoFocus pin is free to move. 
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8.2.3 Lubrication of the X & Y Rails 

In order to keep the motion system running smoothly, the X and Y rails of the motion system will need 

lubrication on weekly base. Apply 0.1ml of lubrication NSK Grease PS2 in accessory box to the X liner 

rail of LV-290 on bi-week base, while apply a small amount of light grade machine oil or PS2 grease to a 

paper or cotton towel and apply to the X rail, and Y rails of LV-290 weekly. 

 

NOTE 

• Clean and lubricate the X linear rail of LV-290 with 0.1ml grease from syringe every two 

weeks to properly maintain the motion system. 

• The lubrication oil for the X linear rail on LV-290 must to be ordered from your authorized 

Roland DG Corporation dealer. Other unknown grease may damage the rail’s life time and 

performance. 

• Always clean and lubricate the X and Y rails of LV-290 after working with material that 

produces lots of debris (such as wood). 

• Too much oil or PS2 grease applied to the Y rails will accelerate the debris building up. 
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8.3 Cleaning the Optics System 
8.3.1 Removing the Mirrors 

We recommend that you check the mirrors once or twice a week to see if they require cleaning. 

If any debris or smoke residue is present, use the following steps to clean them. 

 

NOTE 

• It is highly recommended you remove, clean and replace each mirror once at a time!  

Mirrors: better to clean once two weeks 

Focal Lens: better to clean every time when used 

• Refer to section 8.3.2 on how to clean the mirrors. 

 

The following section will illustrate the location of the four mirrors found on this machine for cleaning. 

 

Mirror 1 

Mirror 1 is located inside the bottom left access door panel of this machine. 

1) Use a #2 Phillips Screwdriver to open the back access panel first, there are three screws need to 
be removed. 

  

2) Open the slot cover on the bottom left side of this machine, there are two screws need to be 
removed. 
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3)  Loosen the thumbscrew as below picture, and then loosen the dust prevention tube by turning 
up. 

  

4)  Remove the three thumbscrews of the black dust cover and take off the black dust cover. 

   

   

5) Unscrew the thumbscrew holding Mirror 1 in place and take out Mirror 1. 

   

  

1 
2 

3 
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Mirror 2, 3, 4 

These mirrors are located in the work table area of this machine.  

 

Mirror 2 

1) Unscrew and remove the black dust cover covering mirror 2. 

  

2) Take off the black dust cover. 

 

3) Unscrew the thumbscrew holding Mirror 2 in place and take out Mirror 2. 

  

 

Mirror 4 

Mirror 2 

Mirror 3 
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Mirror 3 

1) Unscrew the thumbscrew holding mirror 3 in place. 

  

Mirror 4 

1) Unscrew the three thumbscrews securing the lens carriage panel and remove the lens carriage panel 
to reveal mirror 4 and the focal lens. 

   

2) Loosen the top thumbscrew to remove mirror 4 and do the cleaning. 

   

NOTICE 

After cleaning the mirror 4 while putting it back, please place it correctly as following steps, 

or it will affect the cutting / engraving quality. 

  

1 

2 3 
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a. There is a tip that we shall let the silver circle faces up and keep it on the upper part.  
The mirror 4 shall face down while putting it back. 

 

b. We make two marks on the mirror holder for easy recognition. 

 

c. The Mirror 4 faces up is incorrect. 
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d. There is no mark is incorrect. 

  

e. The Mirror 4 is not placing on the gap is incorrect. 

  

8.3.2 Cleaning the Mirrors 

After you have removed each mirror, you will want to inspect each mirror for scratches, smoke residue, 

or debris. If any residue or debris is present, use the following steps to clean the mirrors.  

1) Hold the mirror with the reflective side up, without touching the reflective side of the mirror (DO 

NOT apply any finger pressure or any other cleaning solutions to the mirror surface). 

2) Drape a new sheet of lens tissue over the mirror. 

3) Apply a few drops of methanol on the tissue covered mirror (apply enough so that the tissue absorbs 
just enough solution to cover the mirror surface). 

4) Pull the tissue across the mirror in only one direction. 

5) Repeat the cleaning processes if the mirror is not completely clean after the first attempt. 

6) Make sure that the mirror is completely dry before reinstalling it. 
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 CAUTION 

• If the center of the mirror is scratched, contact your machine representatives for 

replacement. 

• DO NOT apply any finger pressure or any other cleaning solutions to the mirror or focal lens 

surface. 

• The optics components are very fragile, handle carefully and follow the cleaning procedure 

well. 

 
 

8.3.3 Removing and Cleaning the Focal Lens 
1) Unscrew the three thumbscrews securing the lens carriage panel and remove the lens carriage panel 

to reveal the focal lens. 

2) Carefully pull out the focal lens. 

3) Clean the focal lens with a cotton swab and methanol solution. Be sure to clean both sides of the 
focal lens (DO NOT apply any finger pressure or other cleaning solutions to the lens surface). 

4) After cleaning, use a cotton swab to gently dry the focal lens and lens cover. 

   

 

 

  

Pull out the focal lens Remove thumbscrew 



 

                                          213                                  

8.4 Cleaning the Exhaust Duct  

Efficient exhaust ventilation is crucial to laser cutting quality. We suggest you to clean the Exhaust Duct 

from accumulated dust regularly will help to maintain the ventilation efficiency of your laser engraving 

system.  

Step 1. Remove screws fixing the rear door panel of laser machine 

Step 2. Remove screws securing exhaust duct on rear door panel  

Step 3. Open the rear door and take out the exhaust duct to clean with water 

Step 4. Fix and secure the exhaust duct and rear door panel back to the laser machine 

 

 

 
 

Remove screws 

securing rear door 

and exhaust duct 

Take out the 

exhaust duct and 

clean with water 
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Chapter 9 Basic Troubleshooting 
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Quality Problems 

• Check focal length setting under F4 function key > Machine Setting > Set Focus Lens to see if it 
matches the type of the lens installed. 

• Check if the focal lens is installed correctly or if focal lens is not fixed properly. 

• Check if it is caused by the debris or dust builds up in the bearing tracks of X rail. 

• Check if it is caused from the damaged or dirty focal lens and mirror 4 in the lens carriage which 
cannot deliver the laser beam effectively. 

 
Non-operational Problems 

• Laser does not fire 

1. If the red alignment beam is not visible, the laser beam may be misaligned. Adjust the reflection 
mirrors for exact focus. 

2. If the red alignment beam is visible, please check the driver power. The laser power may be set 
to too low for detection. Increase the percentage setting of the Laser Power from the software 
driver or the control panel. 

3. Check if the laser power connector is connected. 

4. For safety purposes, the laser will not fire when the top lid or the front door is open unless the 
door sensors are defeated by shorting them with magnets. 

5. Check water level or temperature of water cooler if the equipped laser requires water cooling. 
The laser tube will automatically shut down itself if the laser tube is over-heated. 

 

NOTE 

• Unplug the machine before examining the mirrors, lens, motion system or any other part 

of the laser system. 

 
Other Problems 

• "Graphic Was Clipped…" Message 

The size or location of graphic image may be bigger or beyond the legal working area. Do not 

place graphic object, especially vectors, right from (3,0) origin position, or 0 at either x or y rail 

of working area on application software. Take Corel Draw for instance, even when the vector 

line’s width has been set to the thinnest, it may still go beyond the border and causes the error. 

If the message appears randomly but frequently even image object is smaller or within the 

legal border, check or change DRAM module, a bad contact or faulty DRAM could cause such 

error. 

• Auto Focus Pin is Not Functioning 

The focus pin could be stocked by greasy residue that gradually forms a coating.  Clean the 

probe with alcohol or acetone. Check the cable of focus pin, there might be a bad contact or 

breakage.
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10.1 Glossary 

Color Fill – Term within the awards and engraving industry used to describe the variety of techniques 

used to add color or contrast to engraving. 

DPI – Dots Per Inch or Pixels Per Inch. The resolution of an image is defined by the amount of dots/pixels 

included in an inch.  The DPI setting of 500, will tell the machine to include 500 laser firings within an 

inch. 

Driver – A software program that allows the computer to communicate with its components and 

peripherals: printers, scanners, monitors, etc. 

Error Diffusion (Dithering Method) - This effect uses a series of random black and white pixels to 

represent shading. 

Firmware – Programming permanently set into a computer’s ROM chips. This information is burned into  

the computer chips and can only be changed by replacing the chips, or in the case of EEROM, by special 

procedure. 

PPI – Pulses Per Inch. PPI determines the gross amount of laser pulses there will be per linear inch. PPI is 

exclusively used for the vector setting. A PPI setting of 500 results in the laser firing every .002” (500 times 

per inch). If the standard lens is producing a vector laser focal point of .007”, then higher  PPI settings will 

result in deeper, overlapping laser pulses. PPI settings lower than 150 will result in the individual laser 

pulses being spread far apart, so they will not touch each other. Low PPI settings are a good example of 

perforate paper. 

Raster – The process of rendering a cutting or engraving by multiple horizontal lines.  For example: when 

cutting out or engraving a square, the raster setting will make the laser use numerous horizontal lines to 

fill in the outlined space. 

Raster Image – An image that is defined as a collection of arranged pixels in a rectangular array of lines. 

A raster image is similar to a “Bitmap” graphics image. 

Raster Line – A raster line is the individual horizontal line that makes up the raster image. 

Serial Port – A connection that allows a computer to send data to a peripheral device one bit at a time. 

Usually it is a COM port that meets the RS232C specification. 

Vector – The process of cutting or engraving an image by using single horizontal, vertical and curved 

lines. For example: when cutting out or engraving the outline of a square, the vector setting will make the 

laser use a thin single line to follow the outline of the shape.
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10.2 Specification Sheet 

* Specifications are subject to change without prior notice. 
* Depending on the material being processed, harmful gases may be generated that could cause 

symptoms such as sore throat, headache, dizziness, etc. 
* Roland DG strongly recommends that you install a deodorizing or local exhaust ventilation system in a 

well-ventilated room. For more information, please contact your local distributor or dealer. For more 
information, please contact your local distributor or dealer. 

LV-290 

Laser Source 40W CO2 Laser 

Work Area 

When with SmartVISION Pro CCD: 

550 mm x 440 mm (21.6 x17.3 in.) 

When without SmartVISION Pro CCD: 

640 mm x 460 mm (25.1 x18.1 in.) Extendable to 740 x 460 mm (29.1 x 18.1 in.)  

Maximum Part Size 

(W x L x H) 
762 x 482.6 x 165 mm (30.0 x 19.0 x 6.4 in.) 

Table Size 790 x 530 mm (31.1 x 20.8 in.) 

Cooling Air-cooled, Operating environment temperature 15°- 30°C (60° - 86°F) 

Drive Closed-loop DC Servo control 

Maximum Motor 

Speed 

When with SmartVISION Pro CCD: 

1016 mm/s (40 in./s) 

When without SmartVISION Pro CCD: 

1524 mm/s (60 in./s) 

Speed Control Adjustable from 0.1-100% (Up to 16 color-linked speed settings per job) 

Power Control Available from 0~100% (UP to 16 colors linked power setting per job) 

Distance Accuracy 0.254mm or 0.1% of move, whichever is greater 

Z-Axis Movement Automatic 

Focus lens Standard 2.0 in., Optional 1.5 in., 2.5 in. & 4.0 in. available 

Resolution (DPI) Available 125, 250, 300, 380, 500, 600, 760, 1000, 1500 

Computer Interface Full speed 2.0 USB, 10 Base-T Ethernet 

Memory Buffer 32MB standard 

Compatible 

Operating Systems 
Windows® 7, 8.1, 10 

Display Panel 
4-line LCD panel showing current file name, total working time, laser power, 

engraving speed, file(s) loaded into memory buffer, setup and diagnostic menus 

Safety 

Class I Laser Product Compliant with EN60825 

Class II Laser Product Compliant with CDRH 

2006/42/EC Machinery Directive Compliance 

Operation Voltage 100-240VAC, 50-60Hz Auto Switching, Max. 15A 

Dimensions (W x L x 

H) 
1125 x 720 x 1005 mm (44.2 x 28.3 x 39.5 in.) 

Weight 167 kg (369 lb.) 

Fume Extraction 

System 

External exhaust system is required, one 4 in. connection on the back of the 

machine 

Included Items 
Power cord, Ethernet cable, USB cable, user's guide, cleaning tissue, mirror 

cleaner, etc. 
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